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1. Allgemeiner Teil 

 

1.1 Beschreibung geografischer Informationssysteme 

 

Ein Geoinformationssystem ist ein rechnergestütztes System, das aus Hard- und 

Software, Daten und Anwendungen besteht. 

Mit ihm können raumbezogene Daten digital erfasst, verwaltet, analysiert und präsentiert 

werden. (vgl. Bill/Fritsch, 1991, zit. n. Lother, Skript 2007, Seite 16) 

 

Die Kartenerstellung (Präsentation) ist eine wichtige GIS-Funktion, um die Information 

der Geodaten einfach und verständlich zu vermitteln. 

Dennoch gibt es eine Reihe weiterer Funktionen, die es ermöglichen, Geodaten zu 

analysieren und zu interpretieren.  

Dazu gehören unter anderem die Selektion (Auswahl) und das Geoprocessing, die 

räumliche Abfrage. 

Dafür sind bestimmte Grundlagen über Geodaten, wie das Geodatenmodell, der 

Raumbezug und die Geometrieelemente usw. nötig. 
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1.2 Ziel und Thema der Diplomarbeit 

 

Ziel dieser Diplomarbeit ist, die folgenden kostenfreien GIS-Viewer bezüglich ihres 

Funktionsumfangs und ihrer Performance zu untersuchen und gegenüberzustellen: 

 

Arc Explorer 9.3.1 

Spatial Commander 1.0.7-0 

gvSIG 1.9 

Quantum GIS 1.4.0 

uDIG 1.1.1 

Map Window 4.7.3  

Tatuk GIS Viewer 1.13.1.370 

Global Mapper 11.02 

TNT Mips free 2009 

 

Die zu untersuchenden Funktionen sind: 

 

Benutzeroberfläche 

Lesen von Vektordaten 

Grafische Ausprägung der Vektordaten 

Lesen von georeferenzierten Rasterdaten 

Grafische Ausprägung der Rasterdaten 

Geografische Abfragen 

Performance  

Digitalisierung 

WMS-/WFS-Dienste 

Druckfunktionalität 

Schreiben von Vektordaten 

Schreiben von Rasterdaten 

Schreiben von georeferenzierten Rasterdaten 
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1.3 Beschreibung der Programme 

 

Arc Explorer 9.3.1 

Der ArcExplorer ist ein kostenfreier, auf Java basierender Geodaten Viewer von der Firma 

ESRI (Environmental Systems Research Institute, Inc.), mit welchem Sie Ihre Geodaten 

auf einfache Weise darstellen, abfragen und auswerten können. (vgl.: http://www.esri-

germany.de/products/arcexplorer/index.html) 

 

Spatial Commander 1.0.7-0 

Der Spatial Commander wurde von der Firma GDV (Gesellschaft für geografische Daten-

verarbeitung mbH) entwickelt und ist eine kostenlose Java Applikation und somit 

plattformunabhängig.  

 

gvSIG 1.9 

Der gvSIG (Generalitat Valencia Sistema de Información Geográfica) wurde von dem 

Privatbetrieb Iver in Zusammenarbeit mit der städtischen Regierung von Valencia und 

der Universität Jaume I, Castellón entworfen.  

Das Programm ist in der Programmiersprache Java geschrieben und  somit plattform-

unabhängig. (vgl.: http://de.wikipedia.org/wiki/GvSIG) 

 

Quantum GIS 1.4.0 

Das Programm Quantum GIS (abgekürzt QGIS) wurde von den Entwicklern QGIS 

Development Team in der Programmiersprache C++ entworfen und dient dem Erfassen, 

Betrachten und Bearbeiten räumlicher Daten.  

QGIS läuft auf den Betriebssystemen: Windows, Mac OS X, Linux, Unix-Derivate.  

(vgl.: http://de.wikipedia.org/wiki/Quantum_GIS)  

 

uDIG 1.1.1 

uDIG (User-friendly Desktop Internet GIS) ist ein kostenfreies, auf Java (Eclipse Platt-

form) basierendes GIS Programm und wurde von der kanadischen Firma Refractions 

Research hergestellt.  

Der Schwerpunkt dieser Anwendung liegt in der Visualisierung von Geodaten.  

(vgl.: http://de.wikipedia.org/wiki/UDig) 

 

Map Window 4.7.3 

Map Window ist ein erweiterbares Open Source GIS-Programm für Windows und wurde 

von dem Map Window GIS-Team entwickelt. Es unterstützt Vektor- und Raster, sowie 

Datenbankformate. (vgl.: http://www.giswiki.org/wiki/MapWindow_GIS)  
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Tatuk GIS Viewer 1.13.1.370 

Der Tatuk GIS Viewer wurde von der polnischen Firma TatukGIS Sp. z o.o. entwickelt 

und dient dem Betrachten und Bearbeiten von Vektor- und Rasterdaten.  

(vgl.: http://www.giswiki.org/wiki/TatukGIS) 

 

Global Mapper 11.02 

Der Global Mapper, entwickelt von der amerikanischen Firma Global Mapper Software LLC 

für Windows, ist keine kostenlose GIS-Anwendung.  

Er kann aber ohne Registrierung mit eingeschränkter Funktionalität kostenlos benutzt 

werden und bietet mehr Möglichkeiten als die bloße Visualisierung räumlicher Daten. 

 

TNT Mips free 2009 

TNT Mips free ist eine kostenlose Version der TNT-Produktfamilie und wurde von der 

Firma Micro Images, Inc. entwickelt.  

Dieses Programm dient der Geodatenanalyse, Bildverarbeitung, Photogrammetrie, dem 

Desktop Mapping, der Kartographie und dem Arbeiten mit relationalen Datenbanken. 

(vgl.: http://www.gisteam.de/produkte/tntlite.htm) 

 

Dieses Programm wurde durch Absprache mit meinem Betreuer des LVG aus der Unter-

suchung ausgenommen, da die Beschränkungen zu groß sind (siehe Abschnitt 2.9) 
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1.4 Computersystem 

 

Für einen Vergleichstest unterschiedlicher Programme ist der verwendete Computer mit 

seinem System von Bedeutung.  

Damit die Softwareprodukte mit einander verglichen werden können, müssen alle Unter-

suchungen auf dem gleichen System erfolgen. 

Alle Programme und deren Anwendungen wurden mit folgendem System untersucht: 

 

Prozessor: Intel Xeon 2x1,7 GHz (Dual Core) 

Arbeitsspeicher: 1 GB RAM 

Grafikkarte: NVidia GeForce FX 5200 

Betriebssystem: Microsoft Windows XP Professional (2002) 

 

 

1.5 Erläuterung der Untersuchungskriterien 

 

In diesem Abschnitt wird die Wahl der Beurteilungskriterien erläutert, mit denen die ver-

schiedenen Programme verglichen werden. 

 

1.5.1 Benutzeroberfläche 

 

Der erste Eindruck ist beim Arbeiten mit einer Software von enormer Wichtigkeit. Nach 

dem Starten des Programms erscheint die Benutzeroberfläche mit der Menüleiste, den 

Icons und dem Anzeigefenster.  

Schon ab diesem Moment entscheidet sich, ob die Software für den Benutzer geeignet 

erscheint, oder nicht. Natürlich muss man sich in jedes Programm einarbeiten und 

dessen Eigenheiten kennen lernen.  

Doch besteht die Möglichkeit zur Wahl zwischen mehreren Programmen, wie es in dieser 

Diplomarbeit der Fall ist, entscheidet man sich am ehesten für eine Software, deren 

grafische Oberfläche den Benutzer anspricht, solange sie alle benötigten Funktionen 

enthält. 

Daher ist das erste Kriterium dieser Untersuchung die Benutzeroberfläche der jeweiligen 

GIS-Viewer. 

In die Funktionsübersicht gehen entweder zwei Punkte „●●“ für gut, einen Punkt „●“ für 

mittel oder ein Strich „−“  für schlecht ein. 

 

Es werden bis zu 5 Punkte vergeben. 
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1.5.2 Lesen von Vektordaten 

 

Für das Arbeiten mit Geoinformationssystemen sind Vektordaten unerlässlich. Sie setzen 

sich aus geometrischen Objekten, wie Punkten, Linien und Flächen (Polygonen) zusam-

men. Der Punkt ist das grundlegende Geometrieelement und besitzt theoretisch keine 

Ausdehnung. Eine gerade Linie (Strecke) wird durch zwei Punkte definiert. Die Kanten 

eines Polygons (Vieleck) werden durch Punkte bestimmt. Die einfachste Form eines Poly-

gons ist ein Dreieck, bzw. ein Quadrat oder Rechteck. 

Vektoren eignen sich besonders gut zum Erfassen, Verwalten und Analysieren räumlicher 

Daten in Geoinformationssystemen. Sie benötigen nicht viel Speicherplatz und können 

mit Hilfe von mathematischen Operatoren untersucht werden. Durch die unterschied-

lichen Anwendungen von Vektoren und eine Vielzahl von Herstellerprogrammen für Geo-

informationssystemen existieren unzählig viele Formate. Untersucht werden die Program-

me daraufhin, ob sie drei wichtige Vektorformate lesen können. 

Das Shapefile (shp) ist ein, von der Firma ESRI für Arc View entwickeltes Vektorformat 

für Geodaten und hat sich inzwischen als Quasi-Standard im Desktop-GIS Bereich ver-

breitet. (vgl.: http://de.wikipedia.org/wiki/Shapefile) 

Zu dem Shape (shp), welches die Geometriedaten speichert, gehören noch zwei weitere 

Dateien: die dbf-Datei, die Sachdaten zu den Geometrien im dBase-Format speichert und 

die shx-Datei, die als Veknüpfung (Geolink) zwischen Geometrie- und Sachdaten dient. 

Des Weiteren wird das Lesen von DXF-Daten untersucht.  

Das Drawing Interchange Format wurde von der Firma Autodesk für das 

Konstruktionsprogramm AutoCAD entwickelt. (vgl.: http://de.wikipedia.org/wiki/DXF)  

Es beschreibt ein CAD-Modell als Text im ASCII-Standard und kann von vielen 

Grafikprogrammen importiert werden. 

Zuletzt wird das GML-Format ebenfalls in die Untersuchung miteinbezogen. 

GML (Geography Markup Language) ist eine Auszeichnungssprache und dient dem 

Austausch raumbezogener Objekte mit deren Geometrien, Attributen und Relationen. 

GML ist durch das OGC (Open Geospatial Consortium) zu einer offiziellen internationalen 

Norm der ISO (International Standard Organisation) definiert worden.  

(vgl.: http://de.wikipedia.org/wiki/Geography_Markup_Language) Da mehrere Versionen 

vorhanden sind, wird die Untersuchung auf 2.x (2.1.2) und 3.x (3.1.1) beschränkt. 

  

In die Bewertung fließen maximal 10 Punkte ein. 

 
 
 
 

 

 



 13 

1.5.3 grafische Ausprägung der Vektordaten 

 

In diesem Abschnitt werden die Möglichkeiten der grafischen Darstellung von Vektor-

daten der Programme beschrieben. Um Vektordaten interpretieren und anschaulich als 

Karte ausgeben zu können werden unterschiedliche Arten der Darstellung benötigt.  

Eine wichtige Funktion ist die Transparenzeinstellung. Vor allem bei flächenhaften Vektor-

daten ist diese von großer Bedeutung, um darunter liegende Informationen (Bsp.: 

Rasterbilder) noch erkennen zu können. Die Transparenz wird meistens über einen 

Schieberegler eingestellt und ist von 0 bis 100 Prozent wählbar. 

Des Weiteren wird untersucht, ob für die Farbwahl der Vektoren ein Farbmischer zur 

Verfügung steht, um die Farben optisch abzustimmen. 

Die nächsten drei Punkte behandeln die Art der Darstellung. Dabei gibt es drei wichtige 

Unterscheidungen: das Einheitssymbol, den Wertebereich und den Einzelwert. 

Einheitssymbol bedeutet, dass jedem Objekt desselben Themas die gleiche Signatur, 

bzw. Farbgebung zugewiesen wird. 

Wie der Begriff Wertebereich schon vermuten lässt, wird anhand der attributiven Merk-

male ein Wertebereich (eine Klasse oder mehrere Klassen) gebildet. Für jede Klasse wird 

dann eine unterschiedliche Farbgebung gewählt (Bsp.: Höhenschichten). 

Bei dem Einzelwert wird für jeden attributiven Wert eines Feldes eine eigene Farbe 

definiert. 

Die nächsten Kriterien beschäftigen sich mit der Geometrieform von Punkten, der Art von 

Linien und Mustern bei Flächen. Der Punkt kann nicht nur kreisförmig, sondern auch bei-

spielsweise quadratisch, dreieckig oder kreuzförmig dargestellt werden. Als Beispiel dient 

ein Kreuz, das den Standort einer Kirche kennzeichnet. Genauso kann eine Linie ent-

weder durchgezogen, gestrichelt oder punktiert sein. Für Einsenbahnlinien werden häufig 

gestrichelte Linien verwendet. Eine Fläche kann entweder farbig ausgefüllt sein, oder eine 

Schraffur enthalten. Für eine differenzierte Darstellung der Bodenbeschaffenheit werden 

zusätzlich zu den Farben noch Muster den Flächen zugewiesen.  

Darüber hinaus kann es sinnvoll sein, wenn die Möglichkeit besteht, benutzerdefinierte 

Symbole für den Punkt zu importieren. 

Für die eindeutige Interpretierung der Vektoren ist eine Beschriftung (Labels) häufig un-

umgänglich. Deswegen fließt diese Funktion auch in die Untersuchung mit ein. 

Abschließend ist für grafische Ausprägung der Vektordaten die Benutzerfreundlichkeit der 

Menüführung von großer Bedeutung. Hier gehen zwei Punkte „●●“ für gut, einen Punkt 

„●“ für mittel oder ein Strich „−“  für schlecht in die Übersicht ein. 

 

Insgesamt können in diesem Abschnitt maximal 10 Punkte erreicht werden. 
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1.5.4 Lesen von georeferenzierten Rasterdaten 

 

Um eine möglichst realitätsnahe Darstellung von Geodaten zu erlangen, ist die Integra-

tion von Rasterdaten in geografischen Informationssystemen unerlässlich. Häufig liefern 

Rasterbilder (Bsp.: Luftbilder) zusätzlich zu den klar abgegrenzten Vektordaten nützliche 

Informationen zu Verläufen in flächenhaften Erscheinungen. Dabei handelt es sich 

meistens um georeferenzierte Rasterdaten, welche in ein übergeordnetes Koordinaten-

system eingepasst werden. Diese Bilder können in unterschiedlichen Formaten gespei-

chert werden.  

Die am häufigsten vorkommenden und in dieser Diplomarbeit untersuchten Bildformate 

sind: TIFF (Tagged Image File Format), JPEG (Joint Photographic Experts Group), GIF 

(Graphics Interchange Format) und PNG (Portable Network Graphics).  

Zusätzlich zu den Bildformaten spielt auch die Art der Georeferenzierung eine Rolle.  

Hier muss zwischen zwei Arten unterschieden werden. Die beste Möglichkeit ist das 

GeoTIFF, eine Rasterdatei, in dessen Header die Georeferenzierung direkt gespeichert 

wird. Diese zusätzlichen Informationen bestehen zum einen aus dem geodätischen Da-

tum, welches das Erdellipsoid bestimmt und seine genaue Lage und Orientierung relativ 

zum Erdkörper definiert, zum anderen aus der Projektion, welche die Abbildung der ge-

krümmten Erde auf eine ebene Fläche angibt. 

Eine weitere Möglichkeit zum Einpassen von Bilddaten in ein Koordinatensystem ist das 

Erzeugen einer zusätzlichen Datei. Bei einem TIFF entsteht dann eine Datei mit der En-

dung TFW (TIFF World File). Hier werden aber im Unterschied zu dem GeoTIFF nicht das 

Datum und die Projektion, sondern nur die Pixelgröße und die Koordinaten der linken 

oberen Ecke gespeichert. Diese zusätzliche Datei kann aber auch für das JPEG-, GIF- und 

PNG-Format erstellt werden und hat dann die Dateiendung JGW, GFW, PGW. 

Daher bestehen die Untersuchungskriterien in diesem Abschnitt aus: GeoTIFF, TIFF (tfw), 

JPEG (jgw), GIF (gfw) und PNG (pgw). 

 

Es werden bis zu 10 Punkte für vergeben. 

 

 

1.5.5 grafische Ausprägung der Rasterdaten 

 

Dieser Abschnitt beschäftigt sich mit den Möglichkeiten zur Darstellung von Rasterbil-

dern. Für die Überlagerung von Vektor- und Rasterdaten oder mehreren Bildern spielt die 

Einstellung der Transparenz eine wichtige Rolle.Dabei handelt es sich um die Transparenz 

des gesamten Bildes. Alle Farbwerte werden gleich transparent geschaltet. Die Stufe der 

Transparenz (Lichtdurchlässigkeit) kann vom Benutzer mit Hilfe eines Schiebereglers 

oder durch die numerische  Eingabe von Prozentwerten selbst bestimmt werden.  
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Die andere Möglichkeit ist die Transparenzeinstellung einzelner Farbwerte. Es wird nur 

die Transparenz für einen bestimmten Farbwert beeinflusst, während die restlichen Farb-

werte unverändert bleiben. 

Ein weiterer Punkt ist die Veränderung einzelner Farbwerte. Um in der Darstellung eines 

Rasterbildes eine Farbe zu ändern, müssen die Farbwerte aufgelistet und änderbar sein. 

Auch die Einstellmöglichkeit der Helligkeit wird hier untersucht, um vor allem bei Halb-

tonbildern (Bsp.: Luftbilder) Informationen zu verstärken. 

Zusätzlich fließt auch die Benutzerfreundlichkeit der Menüführung bei der grafischen Aus-

prägung von Rasterdaten in der Übersicht mit ein. Es stehen zwei Punkte „●●“ für gut, 

einer „●“ für mittel oder ein Strich „−“  für schlecht. 

 

Für die Bewertung werden maximal 6 Punkte vergeben. 

 

 

1.5.6 geografische Abfragen 

 

Für das gezielte Editieren von Vektordaten in geografischen Informationssystemen ist die 

Selektion (Auswahl) ein wichtiges Werkzeug. Um ein Geoobjekt auswählen zu können, 

gibt es zum einen die visuelle Selektion mit Hilfe einer Bereichsauswahl oder einer Einzel-

identifikation, die vom Benutzer selbstständig ausgeführt wird.  

Da zu jedem Geoobjekt zusätzlich Merkmale (Attribute) in einer Tabelle gespeichert sind, 

wird eine Selektion aber häufiger über die Attributwerte gesteuert. Dabei handelt es sich 

um attributive (merkmalsbasierte) Abfragen. Sie werden in der Regel über die Daten-

banksprache SQL (Structured Query Language) umgesetzt. Die Geometrieobjekte, die ein 

bestimmtes Merkmal (Bsp.: Fläche > 100 m²) besitzen werden ausgewählt und können 

dann bearbeitet werden. 

Zusätzlich zu der attributiven Abfrage besteht die Möglichkeit einer räumlichen Abfrage. 

Hier handelt es sich um eine Selektion, welche nicht auf Merkmalen beruht, sondern auf 

räumlichen Eigenschaften der Geoobjekte.  

Oft werden Einflüsse bestimmter Objekte mit Hilfe von Entfernungen bestimmt. Dazu ist 

die Pufferbildung eine häufig angewendete Funktion, bei der ein Abstandsbereich belie-

biger Dimension (Bsp.: Radius) ausgehend von einem Geometrieobjekt (Bsp.: Punkt) ge-

bildet wird. 

In diesem Abschnitt werden die GIS-Viewer auf das Vorhandensein bestimmter Abfrage-

funktionen überprüft.  

Der erste Punkt der attributiven Abfragen  beschäftigt sich damit, ob die Attributtabellen 

der Themen auch ohne Selektion von Objekten geöffnet werden können.  
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Das wichtigste Werkzeug bei den attributiven Abfragen ist der Query Builder, der mit Hil-

fe der Datenbanksprache SQL gesuchte Merkmale auswählt.  

Als nächstes wird die Verknüpfung zweier Tabellen, der so genannte Join, beschrieben.  

Damit können anhand eines Schlüsselfeldes weitere Attribute an die Tabelle des Aus-

gangsdatensatzes angehängt werden. Es werden hierbei nur solche Datensätze in eine 

neue Datei geschrieben, die Übereinstimmungen hinsichtlich der ausgewählten Schlüs-

selfelder aufweisen. 

Die räumlichen Abfragen beschäftigen sich mit dem Geoprozessing. Zunächst wird die 

Pufferfunktion überprüft.  

Zusätzlich werden folgende Operatoren untersucht: 

Dissolve: führt Flächen von zwei Eingabethemen zusammen, die den gleichen Wert in 

einem angegebenen Attribut aufweisen 

Intersect: schneidet aus dem ersten eingegebenen Thema anhand eines zweiten Über-

lagerungsthemas Objekte aus und stellt diese in einem Ausgabethema mit den Attributen 

beider Eingabethemen zur Verfügung. 

Union: vereinigt Objekte vom Typ Polygon des ersten Eingabethemas mit den Objekten 

eines zweiten Eingabethemas vom gleichen Typ. Das Ausgabethema enthält alle Objekte 

und Attribute beider Eingabethemen. 

Merge: führt die Objekte von zwei Eingabethemen zusammen. Die Attribute beider Einga-

bethemen bleiben im Ausgabethema enthalten.  

 

Insgesamt werden für diesen Abschnitt bis zu 10 Punkte für die Bewertung vergeben. 

 

 

1.5.7 Performance 

 

Wichtig für das Arbeiten mit einer Software ist deren Geschwindigkeit und Stabilität. 

Um Geodaten sinnvoll erfassen, verarbeiten, analysieren und präsentieren zu können, 

spielt der zeitliche Aufwand eine große Rolle. Wenn die Rechenzeit (Wartezeit) beim 

Arbeiten mit mehreren Geodaten ansteigt und das Programm auch noch abstürzt, ist das 

nicht nur ärgerlich, sondern auch nicht wirtschaftlich. 

Untersucht wird die Performance der Viewer beim Arbeiten mit Vektor- und Rasterdaten. 

Bei den Vektordaten gibt es drei Kategorien unterschiedlicher Dateigrößen. Verwendet 

werden Shape-Dateien mit den dazugehörigen shx- und dbf-Dateien. Den größten Spei-

cherplatz benötigen die dbf-Dateien, da sie eine Menge Attributinformationen zu den 

Geometrien enthalten. 

Die Dateigrößen für den Test sind: 27 MB, 83 MB und 144 MB. 
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Die Bewertung basiert auf dem Arbeiten mit den Vektordaten. Dazu gehören Prozesse, 

wie dem Lesen der Daten, Zoomlevel verändern, verschieben des Ausschnitts, öffnen der 

Attributtabelle, selektieren von Geometrien und attributiver Abfragen. 

Die Untersuchung der Performance bei Rasterdaten besteht aus vier Dateien. Verwendet 

wurden hier vier digitale topographische Karten im Maßstab 1:25.000.  

Für den ersten Test waren die Rasterbilder komprimiert (Packbits Komprimierung) und 

hatten eine Farbtiefe von acht Bit. Im zweiten Test besaßen die Bilder keine Komprimie-

rung und eine Farbtiefe von 24 Bit. Für die dritte Untersuchung hatten die Rasterdateien 

dieselben Eigenschaften, wie bei dem zweiten Test. Sie wurden nur noch auf 150 Prozent 

skaliert. 

Somit sind die drei Dateigrößen für die Performance: 85 MB, 263 MB und 577 MB. 

Wie bei den Vektordaten wurde hier mit den Rasterbildern gearbeitet. Untersuchungs-

kriterien waren das Lesen der Daten, Zoomen, Verschieben und Einstellen der Trans-

parenz. 

Die Untersuchung der Performance wurde für alle Viewer auf dem gleichen System 

durchgeführt (siehe Abschnitt: 1.4 Computersystem). 

 

Das Ergebnis der Performance unterliegt folgendem Bewertungssystem (siehe Abschnitt 

1.6 Bewertungssystem):  

Zwei Punkte „●●“ stehen für gut, ein Punkt „●“ für mittel und ein Strich „–„ für schlecht. 

Manchmal sind die Punkte in Klammern gesetzt „●“. Das bedeutet, dass die Bewertung 

dazwischen liegt. Die einzelnen Bewertungen der Performance sind als Tabelle in den je-

weiligen Abschnitten der einzelnen Programme eingefügt. 

 

Hier können bis zu 10 Punkte erreicht werden. 

 

 

1.5.8 Digitalisierung 

 

Analoge Rasterdaten können mit Hilfe eines Scanners digitalisiert werden. Vektordaten 

bestehen aus Anfgangs- und Endpunkten, die durch gerade oder gekrümmte Linien ver-

bunden sind. Sie benötigen weniger Speicherplatz als flächenhafte Informationen, die in 

Pixeln (picture elements), kleinsten Bildteilen gespeichert werden. 

Um Vektordaten selbst erstellen zu können , muss die Software eine Funktion zum Digi-

talisieren enthalten. Mit Digitalisieren ist das sogenannte Redlining gemeint. Dabei wird 

ein Overlay beispielsweise auf eine Rasterdatei erzeugt.  

Das Schreiben der digitalisierten Vektordaten wird in diesem Abschnitt aber nicht unter-

sucht, da sich der Abschnitt 1.5.11 (Schreiben von Vektordaten) damit beschäftigt.  
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Zusätzlich zu den Geoobjekten müssen deren Merkmale in Form einer Tabelle verwaltet 

werden können. In der Bewertung geht es ausschließlich darum, ob die jeweilige Soft-

ware eine Funktion für das Digitalisieren enthält. 

 

Es werden maximal 7 Punkt vergeben. 

 

 

1.5.9 WMS-/WFS-Dienste 

 

WMS (Web Map Service) und WFS (Web Feature Service) sind Webdienste, zur Visuali-

sierung von Geodaten. Sie können grundsätzlich über das HTTP (Hyper Text Transfer 

Protokoll) angesprochen werden. Die Spezifikation dieser beiden Dienste wurde vom OGC 

(Open Geospatial Consortium) verfasst. Darin sind die Parameter beschrieben, die für 

eine Abfrage benötigt werden. 

Ein WMS-Dienst stellt Karten und Luftbilder in Form von Rasterdaten und deren Meta-

informationen zur Verfügung. 

Ein WFS-Dienst beschränkt sich auf den Zugriff von Vektordaten. Er ruft die, in Daten-

banken abgelegten, geographischen Features ab und gibt sie in dem unabhängigen 

Dateiformat GML (Geography Markup Language) zurück. Ein Feature ist die allgemeine 

Abstraktion eines realen Phänomens. Ein Feature Type ist die Darstellung durch einen 

Namen, mit den zugehörigen Attributen, bei geographischen Feature Types durch eine 

Geometrie. Überprüft werden die Programme, ob sie sie eine GML 2.x- und GML 3.x-

Schnittstelle beinhalten. 

Nach dem Importieren von WMS-Layern wurden die Rasterbilder bei einigen Viewern 

nicht angezeigt. Das liegt daran, dass die Darstellung maßstabsabhängig ist und die 

Rasterbilder nur zwischen einem minimalen und maximalen Maßstab visualisiert werden 

können. 

 

In diesem Abschnitt gehen bis zu 6 Punkte in die Bewertung ein. 

 

 

1.5.10 Druckfunktionalität 

 

Nach dem Erfassen, Verarbeiten und Analysieren von Geodaten ist die Präsentation wich-

tig, um ein verständliches Ergebnis der geleisteten Arbeit zu erhalten. Die häufigste Form 

ist die Karte. Zum Beispiel können mit thematischen Karten bestimmte Sachverhalte 

(Bevölkerungsanzahl) wiedergegeben werden. 
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Da eine Karte aber nicht nur in digitaler Form auf dem Bildschirm, sondern auch analog 

als Ausdruck benötigt wird, ist die Druckfunktionalität eines GIS-Viewers von großer Be-

deutung. 

Die Untersuchungskriterien in diesem Abschnitt beschäftigen sich zuerst mit den vorhan-

denen Kartenkomponenten. Dazu zählen Textelemente, eine Legende und eine korrekte 

Maßstabsleiste. 

Des Weiteren fließt in die Beurteilung mit ein, ob die einzelnen Komponenten mit Hilfe 

der Maus händisch platziert werden können. 

Die Software sollte auch in der Lage sein, in Formatgrößen DIN A4 und DIN A3 zu 

drucken. 

Zuletzt wird überprüft, ob in einem bestimmten Maßstab gedruckt werden kann. Ein 

Ausdruck im Maßstab 1:25.000 muss eine Strecke, unabhängig der Formatgröße, von 

einem Kilometer auf der Erdoberfläche in vier Zentimeter abbilden. 

 

Hier kann ein Programm maximal 5 Punkte erreichen. 

 

 

1.5.11 Schreiben von Vektordaten 

 

Nachdem Bearbeiten der Vektordaten entstehen neue Geoobjekte. Um diese Ergebnisse 

speichern zu können, muss untersucht werden, ob die GIS-Viewer auch Vektordaten 

schreiben können. 

In die Beurteilung gehen, wie im Abschnitt 1.4.2 (Lesen von Vektordaten), die Vektor-

formate Shape, DXF und GML in der Version 2.x und 3.x mit ein.  

 

Es sind hier bis zu 8 Punkte zu vergeben. 

 

 

1.5.12 Schreiben von Bildern 

 

Da die Ergebnisse nach der Bearbeitung der Geodaten auch festgehalten werden können, 

beschäftigt sich dieser Abschnitt mit dem Schreiben von Bildern.  

Die Programme werden auf folgende Bildformate untersucht:  

TIFF (Tagged Image File Format), JPEG (Joint Photographic Experts Group), GIF 

(Graphics Interchange Format), PNG (Portable Network Graphics) und BMP (Bitmap). 

 

Es werden maximal 5 Punkte erreicht werden. 
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1.5.13 Schreiben von georeferenzierten Rasterdaten 

 

Im Abschnitt 1.5.4 wurde das Lesen von georeferenzierten Rasterdaten behandelt.  

Dieser Abschnitt beschäftigt sich nun mit dem Schreiben von georeferenzierten Raster-

daten.  

Untersucht werden folgende Formate:  

GeoTIFF, TIFF (tfw), JPEG (jgw), GIF (gfw) und PNG (pgw). 

 

In diesem Abschnitt können die Programme bis zu 8 Punkte erreichen. 

 

 

1.6 Bewertungssystem 

 

Anlage1 

Für eine Bewertung der einzelnen Programme wird zunächst eine Übersicht über die 

Funktionen erfasst. Hier wird untersucht, ob das jeweilige Untersuchungskriterium erfüllt 

wird. Ist die Funktion vorhanden, oder nicht- ja oder nein.  

Dieses wird für ja in einem Punkt „●“ ausgedrückt und einem Strich „−“ für nein.  

Die Untersuchungskriterien Benutzeroberfläche, Benutzerfreundlichkeit und Performance 

werden mit einer qualitativen Aussage angegeben. Diese differenziert, wie gut das Unter-

suchungskriterium erfüllt wird. Hier gibt es drei Abstufungen: zwei Punkte „●●“ für gut, 

einen Punkt „●“ für mittel und einen Strich „−“ für schlecht. Die qualitative Aussage be-

ruht auf meinem Empfinden, wie sich die einzelnen Programme verhalten. Deshalb ist 

dieses System nur bedingt objektiv. 

 

Diese Punkte bilden jedoch noch nicht meine Bewertung. Da manche Funktionsbereiche 

mehr und manche weniger Untersuchungskriterien beinhalten, würde diese Punktvertei-

lung meiner Ansicht nach zu keiner gerechten Aussage führen. 

 

Anlage 2 

Deswegen habe ich zunächst für jeden Funktionsbereich die maximal zu erreichenden 

Punkte aufgeführt. Diese Punkte geben an, wie stark sich jeder Funktionsbereich auf das 

Gesamtergebnis auswirkt. Insgesamt kann jedes Programm bis zu 100 Punkte erreichen.  

In den nächsten Spalten sind die Programme mit ihren erreichten Punkten aufgelistet.  

In der letzten Zeile ist das jeweilige Ergebnis angegeben. 
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2 Vergleich der Programme 

 

2.1 Arc Explorer 9.3.1 

 

2.1.1 Benutzeroberfläche 

 

Die Benutzeroberfläche ist hier sehr einfach gehalten, aber nicht in deutscher Sprache.  

Die Menüleiste enthält sechs Reiter für weitere Funktionen und eine überschaubare An-

zahl an Icons, die groß genug und grafisch einwandfrei interpretierbar sind. Auf der 

linken Seite des Anzeigefenster befindet sich die Leiste mit den importierten Themen. 

 

 
Abb. 1: Die Benutzeroberfläche des Arc Explorers 9.3.1 
 

Die Benutzeroberfläche ist mittelmäßig bewertet. 

 

 

2.1.2 Lesen von Vektordaten 

 

Das Programm liest Shape- aber weder DXF- noch GML-Dateien. 

Zu Beginn gab es Schwierigkeiten beim Öffnen meiner Testdaten (ATKIS-Shapes).  
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Von 13 Themen wurden maximal 6 gelesen und es gab eine Fehlermeldung (siehe Abb. 

2). Es wurde für weitere Details auf die Message Console verwiesen. Die Fehlermeldung 

lautete: 

com.esri.mo.file.shp.ShapefileFolder$c_ 

com.esri.mo.file.shp.InvalidFieldNameException: The field name () has an invalid length 

in (C:\schneider\testdaten\vektordaten\shp\atkis\7833\bahnen.dbf) 

  

 
               Abb. 2: Fehlermeldung bei einigen ATKIS-Shapes-Dateien 
 

Daraus war zu entnehmen, dass sich das Problem auf die Feldbezeichnungen der dbf-

Datei bezieht. Nach Rücksprache mit der Firma ESRI ist beim Arbeiten mit dem Arc 

Explorer  9.3.1 streng auf die Feldbezeichnungen der Attributtabellen zu achten. Es 

dürfen keine Sonderzeichen, außer Unterstriche verwendet werden und die Bezeichnung 

darf nicht mehr als 10 Zeichen beinhalten. Zusätzlich darf der Tabellenname nicht mit 

einer Zahl oder mit einem Unterstrich beginnen, wie es hier der Fall war. Manche ATKIS-

Shape-Dateien haben eine Spalte _KSN. Nach dem Entfernen des Unterstriches wurden 

alle Shape-Daten gelesen.  

 

 

2.1.3 grafische Ausprägung der Vektordaten 

 

Das Menü mit den Eigenschaften eines Themas ist durch einen Doppelklick auf das 

Thema in der Themenleiste, oder über Layer > Layer Properties im Kopf des Fensters 

erreichbar. 

Eine Transparenz kann weder bei Punkten, Linien oder Flächen eingestellt werden.  

Die Vektordaten können als Einheitssymbol, Wertebereich oder Einzelwert dargestellt 

werden.  

Die Farbwahl der Geometrieelemente erfolgt entweder durch die vorgegebenen Farben 

oder einen Farbmischer. 

Es können den Flächen Muster, den Linien bestimmte Linienarten und den Punkten unter-

schiedliche Punktsymbole zugewiesen werden.  

Zusätzlich gibt es die Möglichkeit benutzerdefinierte Punktsymbole zu importieren. 
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Auch eine Beschriftung der Vektordaten ist über die Wahl einer Attributspalte möglich. 

Die Menuführung ist auch hier sehr ansprechend, übersichtlich und auf das Wesentliche 

beschränkt. Sie wird mit gut bewertet. 

 

 

2.1.4 Lesen von georeferenzierten Rasterdaten 

 

Vor dem Öffnen muss im Catalog der File Type von Shapefiles auf Image Files umgestellt 

werden, damit die Rasterdateien angezeigt werden. 

Der Arc Explorer liest die Rasterformate TIFF (tfw), JPG (jgw), PNG (pgw) und GIF (gfw) 

mit dem Worldfile, das die linke obere Ecke des Bildes festlegt. Das GeoTIFF kann nicht 

gelesen werden. 

 

 

2.1.5 grafische Ausprägung der Rasterdaten 

 

Aufgerufen wird die grafische Ausprägung von Rasterdaten über einen Doppelklick auf 

das Thema oder über Layer > Layer Properties. Hier gibt es kaum Möglichkeiten, auf die 

Rasterdaten einzuwirken.  

Die Transparenz kann über einen Schieberegler für das gesamte Bild eingestellt werden. 

Eine Transparenz für einzelne Farbwerte oder das Ändern der Farbwerte bei Paletten-

bildern ist nicht möglich.  

Auch die Helligkeit kann nicht beeinflusst werden. 

Die Menüführung ist übersichtlich und erhält die Bewertung gut. 

 

 

2.1.6 geografische Abfragen 

 

Zunächst ist zu erwähnen, dass der Arc Explorer nicht die Möglichkeit bietet, die Attribut-

tabelle eines Themas ohne selektierte Objekte zu öffnen. Die Sachdaten können nur ein-

gesehen werden, wenn vorher eine Auswahl der Geometrieelemente erfolgt ist. 

Eine attributive Abfrage ist mit Hilfe des Query Builders möglich. Dabei können bestim-

mte Merkmale über die Datenbanksprache SQL abgefragt werden.  

Die, den Bedingungen entsprechenden Attribute werden dann in der Tabelle markiert, 

wie auch die Geometrien im Anzeigefenster. 

Ein Tabellen-Join kann nicht durchgeführt werden. 

Bei den räumlichen Abfragen ist nur eine Pufferfunktion vorhanden. Operatoren, wie 

Dissolve, Intersect, Union oder Merge können nicht angewandt werden. 
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2.1.7 Performance 

 

Vektor 

Der Arc Explorer war beim ersten Test mit 27 MB gut in der Performance. Nur bei den 

attributiven Abfragen war das Ergebnis nicht überragend. Der zweite Test mit 83 MB war 

vor allem beim Lesen, Ändern der grafischen Ausprägung, Öffnen der Attributtabelle und 

der attributiven Abfrage nicht mehr ganz so überzeugend. Deswegen war das Ergebnis 

hier mittelmäßig. Bei der dritten Untersuchung mit einer Dateigröße von 144 MB war das 

Ergebnis noch etwas schwächer. Hier zeigten sich teilweise zu große Wartezeiten beim 

Öffnen der Attributtabelle und bei der attributiven Abfrage. Die Grenze des Arc Explorers 

ist erreicht. Das Ergebnis belief sich auch hier auf mittelmäßig. 

 

 27 MB 83 MB 144 MB 

Lesen ●● ● ● 

Zoom ●● ●● ● 

Verschieben ●● ●● ●● 

Symbolik ändern ●● ● ● 

Tabelle öffnen ●● ● (●) 

attributive Abfrage (●) (●) - 

Ergebnis ●● ● ● 
Tabelle 1: Vektorperformance des Arc Exploreres 9.3.1  

 

 

Raster 

Der Test mit den Rasterdaten in der Größe von 85 MB war durchweg gut. Auch bei den 

beiden weiteren Untersuchungen mit 263 MB und 577 MB ist das Ergebnis noch gut. 

 

 85 MB 263 MB 577 MB 
Lesen ●● ●(●) ●(●) 
Zoom ●● ●● ●● 
Verschieben ●● ●(●) ●(●) 
Transparenz ●● ●(●) ●(●) 
Ergebnis ●● ●● ●● 
Tabelle 2 : Rasterperformance des Arc Exploreres 9.3.1 

 

 

2.1.8 Digitalisierung 

 

Der Arc Explorer enthält keine Funktion zur Digitalisierung von Vektordaten. 

 

 

 

 



 25 

2.1.9 WMS-/WFS-Dienste 

 

Es können weder WMS-, noch WFS-Layer importiert werden. 

 

 

2.1.10 Druckfunktionalität 

 

Über den Reiter File > Print kann das Kartenfenster gedruckt werden.  

Das Erzeugen von Textelementen, Legenden und Maßstabsleisten ist nicht möglich.  

Es können zwar die Maßstabsleiste und Maßstabszahl über den Reiter View > scalebar 

aktiviert werden, doch erscheinen diese nicht auf dem Ausdruck.  

Einzig die Themenleiste kann über View > Legend angezeigt und gedruckt werden. 

Beim Druck auf eine Papierseite von DIN A3 fehlt über die Hälfte des Anzeigefensters. 

Auf DIN A4 ist alles vollständig. 

Es ist nicht möglich, einen bestimmten Maßstab numerisch zu definieren. Er kann nur 

durch die Zoomfunktion annähernd bestimmt werden. Auch hier ist beim Format DIN A3 

nicht alles vorhanden. 

 

 

2.1.11 Schreiben von Vektordaten 

 

Der Arc Explorer kann keine Vektordaten schreiben. Weder im Shape-, noch DXF- oder 

GML-Format. 

 

 

2.1.12 Schreiben von Bildern 

 

Der Inhalt des Anzeigefensters kann über den Reiter Edit > Copy Map Image to File… als 

Rasterdatei gespeichert werden. Das Format ist ein JPG und kann auch nicht geändert 

werden. 

 

 

2.1.13 Schreiben von georeferenzierten Rasterdaten 

 

Der Arc Explorer kann keine georeferenzierten Rasterdaten schreiben. 
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2.1.14 Fazit 

 

Der Arc Explorer 9.3.1 von ESRI ist ein reiner Viewer. Leider liest er nur das Shape-

Format bei Vektordaten. Bei den Rasterdaten können die Formate dieser Untersuchung, 

außer dem GeoTIFF, importiert werden. Eine gute grafische Ausprägung der Geodaten ist 

gegeben. Der Viewer ist nicht geeignet für räumliche Abfragen. Die Performance ist 

durchweg erfreulich. Sonstige Arbeiten, wie das Digitalisieren, das Nutzen von Web-

dienste, der Druckerstellung, dem Schreiben von Daten können mit diesem Programm 

nicht durchgeführt werden. 

 

Das Gesamtergebnis der Bewertung des Arc Explorers 9.3.1  beträgt 33,7 Punkte . 
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2.2 Spatial Commander 1.0.7-0 

 

2.2.1 Benutzeroberfläche 

 

Beim Spatial Commander 1.0.7-0 ist die Menüleiste nicht überladen von Icons, die durch 

ihre Größe und grafische Gestaltung gut zu erkennen sind. Die Sprache ist in deutsch 

gehalten. Mit Hilfe von sechs Reitern können weitere Funktionen bedient werden. Neben 

dem Anzeigefenster befindet sich links eine Leiste mit den Themen. Zusätzlich ist noch 

ein Übersichtsfenster vorhanden, das vom Benutzer frei bewegt werden kann. 

  

 
Abb. 3: Benutzeroberfläche des Spatial Commanders 1.0.7-0 

 

Unterhalb des Anzeigefensters werden der Maßstab und die Koordinaten des Themas 

angezeigt. Die Benutzeroberfläche erhielt eine gute Bewertung. 

 

 

2.2.2 Lesen von Vektordaten 

 

Der Spatial Commander liest sowohl Shape-, als auch DXF-, jedoch keine GML-Dateien. 
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2.2.3 grafische Ausprägung der Vektordaten 

 

Die Themeneigenschaften können beim Spatial Commander, ähnlich wie beim Arc 

Explorer, entweder über einen Doppelklick auf das Thema selber, oder in der Menüleiste 

über Themen > Eigenschaften, aufgerufen werden. Die grafische Darstellung kann über 

den Reiter Symbolik erreicht werden. 

Die Transparenz kann über einen Schieberegler (siehe Abb. 4) für Polygone, nicht aber 

für Linien und Punkte, eingestellt werden. 

Den Geometrieelementen können voreingestellte Farben oder vom Benutzer, mittels 

eines Farbmischer selbst erstellte Farben zugewiesen werden. Dabei stehen der RGB- 

und HSB-Farbraum zur Verfügung.   

 

 
                     Abb. 4: Darstellungsmöglichkeiten bei Polygonen 

 

Zur Wahl der Darstellungsart stehen die Funktionen Einheitssymbol, Einzelwert und 

Wertebereich. 

Unter dem Reiter Einzelwert wird jedem Wert eine Farbe zugewiesen. Dazu müssen das 

Feld und das Farbschema gewählt werden. Es können entweder alle Werte oder eine 

Auswahl in die Liste geladen werden. 
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Bei dem Wertebereich können aber auch die Werte, abgestuft in Klassen, zusammen-

gefasst wiedergegeben werden. Hierfür müssen zuerst das Feld, dann die Klassenanzahl 

und der Typ der Klassifikation (gleiche Abstände usw.), gewählt werden. 

Des Weiteren können unterschiedliche Punktsymbole, die Linienart und  Muster für 

Flächen (siehe Abb. 4) definiert werden. 

Es können auch benutzerdefinierte Punktsymbole importiert werden. 

Zusätzlich gibt es die Möglichkeit einer Beschriftung der Objekte. 

Die Benutzerfreundlichkeit ist ausgesprochen gut, da das Menü übersichtlich und einfach 

zu bedienen ist. 

 

 

2.2.4 Lesen von georeferenzierten Rasterdaten 

 

Es werden alle in die Untersuchung einbezogenen georeferenzierten Rasterformate 

(GeoTIFF, TIFF mit tfw, JPEG mit jgw, PNG mit pgw und GIF mit gfw) problemlos 

gelesen. 

 

 

2.2.5 grafische Ausprägung der Rasterdaten 

 

Die Rastereigenschaften können wie die Themeneigenschaften bei Vektordaten auf-

gerufen werden. Die Transparenzeinstellung für das gesamte Bild wird wieder über einen 

Schieberegler gesteuert.  

Die einzelnen Farben werden sinnvoller Weise nur bei Palettenbildern, nicht bei Halbton-

bildern, aufgelistet und können verändert werden (siehe Abb. 5). Somit kann auch eine 

Transparenz für einen einzelnen Farbwert erstellt werden. 
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             Abb. 5: grafische Ausprägung von Rasterdaten (Palettenbild) 

 

Eine Möglichkeit, die Helligkeit zu verändern, ist nicht gegeben. 

Die Benutzerfreundlichkeit ist gut bewertet worden. 

 

 

2.2.6 geografische Abfragen 

 

Die zu den Geometrieelementen gehörende Attributtabelle kann über die rechte Maus-

taste auf das Thema Attributtabelle öffnen… aktiviert werden. Das Thema muss vorher 

aber mit der linken Maustaste markiert werden.  

Unterhalb der Tabelle befindet sich ein Button Bearbeiten. Hier können Felder der Tabelle 

hinzugefügt, entfernt und umbenannt, sowie die markierten Zeilen nach oben oder unten 

geschoben werden. Zusätzlich kann man die Sortierung (aufsteigend, absteigend) 

einstellen. 

Der Query Builder kann ebenfalls über dieses Menü geöffnet werden (siehe Abb. 6).  
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                        Abb. 6: Query Builder des Spatial Commander 1.0.7-0 

 

Zuerst muss man das Thema bestimmen, in dem etwas abgefragt werden soll. Als 

nächstes kann die Methode gewählt werden: neue Selektion erzeugen, zur Selektion 

hinzufügen oder Selektion einengen. Danach muss die Spalte gewählt werden und die 

SQL-Anweisung eingegeben werden. 

Die Möglichkeit, Tabellen zu verbinden (Join), ist gegeben. Dazu muss zunächst unter 

dem Reiter Bearbeiten der Editiermodus aktiviert und dann der Assistent zur 

Geoverarbeitung… gewählt werden. 

Bei den räumlichen Abfragen sind alle Operatoren (Dissolve, Intersect, Union und 

Merge), die untersucht werden, vorhanden (siehe Abb. 7).  
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Abb. 7: Das Menu zu den räumlichen Abfragen, sowie dem Tabellen-Join 

 

Das Menü zur Geoverarbeitung bietet Abbildungen und einen kurzen beschreibenden Text 

zu den einzelnen Funktionen. Es ist sehr übersichtlich und schrittweise gut beschrieben. 

 

 

2.2.7 Performance 

 

Vektor 

Die erste Testserie mit 27 MB war in allen Bereichen sehr zufrieden stellend. Es gab zwar 

Wartezeiten beim Öffnen der Tabelle und den attributiven Abfragen, die sich aber nicht 

weiter drastisch ausgewirkt haben. Die zweite Untersuchung mit einer Dateigröße von 83 

MB verhielt sich ähnlich der ersten. Doch die Performance beim Lesen, Verschieben und 

der grafischen Ausprägung hatte nachgelassen. Der dritte Test mit 144 MB zeigt vor 

allem bei den attributiven Abfragen die Grenze des Viewers. Das Ergebnis beläuft sich auf 

mittelmäßig. 

 

 

 

 

 

 



 33 

 27 MB 83 MB 144 MB 
Lesen ●● ● ● 
Zoom ●● ●● ● 
Verschieben ●● ● ● 
Symbolik ändern ●● ● (●) 
Tabelle öffnen ● ● ● 
attributive Abfrage ● ● - 
Ergebnis ●● ● ● 
Tabelle 3: Vektorperformance des  Spatial Commanders 1.0.7-0 

 

 

Raster 

Die erste Untersuchung mit 85 MB fällt gut aus. Dagegen ist das Ergebnis beim zweiten 

und dritten Test mittelmäßig. 

 

 85 MB 263 MB 577 MB 
Lesen ●(●) ● ● 
Zoom ●● ●(●) ●(●) 
Verschieben ●● ● ● 
Transparenz ●● ● ● 
Ergebnis ●● ● ● 
Tabelle 4: Rasterperformance des Spatial Commanders 1.0.7-0 

 

 

2.2.8. Digitalisierung 

 

Damit man mit der Digitalisierung beginnen kann, muss zunächst der Editiermodus ge-

startet werden. Diesen findet man unter dem Reiter Bearbeiten > Editiermodus ein-

schalten. Danach kann man in der Menüleiste das Zielthema wählen, in das die neu 

erstellten Vektoren gespeichert werden sollen.  

Wenn man die neuen Vektoren nicht in ein vorhandenes Thema schreiben will, muss ein 

neues angelegt werden. Dies ist unter dem Reiter Ansicht > Thema hinzufügen und 

Neues Thema erzeugen… möglich (siehe Abb. 8). 
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             Abb. 8: Menu zum Erstellen eines neuen Themas 

 

Hier kann zunächst unter Punkt 1 das Dateiformat gewählt werden: Shp (ESRI 

Shapedatei) oder mbs (MapBuilder Shapedatei). Des Weiteren muss die Geometrieart 

des Themas festgelegt werden: Punkt, Linie (Polylinie) oder Fläche (Polygon).  

Unter Punkt 2 werden der Speicherort und die Bezeichnung des Themas definiert.  

Punkt 3 beschäftigt sich mit der Attributtabelle. Hier können die Feldbezeichnung, der 

Datentyp (Bsp.: Zahl, Text) und die Zeichenlänge eingestellt werden. 

Nach dem Aktivieren des Editiermodus kann mit der Digitalisierung begonnen werden.  

Je nach gewünschtem Geometrieelement können nun Punkte, Linien oder Flächen mit 

Hilfe der Funktion in der Menüleiste gezeichnet werden.  

Weitere Funktionen sind: Stützpunkte editieren, verschieben und kopieren der 

Geometrieelemente, sowie den letzten Bearbeitungsschritt rückgängig machen. 

Zusätzlich können Flächen geteilt, subtrahiert, kombiniert und Schnittflächen gebildet 

werden. 

Die Attribute können dann in die Tabelle geschrieben werden. 

Ist die Digitalisierung abgeschlossen muss der Editiermodus deaktiviert werden.  

Jetzt kann man die neu erstellten Geometrien samt deren Merkmale speichern. 
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2.2.9 WMS-/WFS-Dienste 

 

Bevor die Geodaten eines WMS-Dienstes angefordert werden können, muss der Verbin-

dungstyp gewählt werden. Diesen findet man unter dem Reiter Datei > Einstellungen > 

Verbindung. Proxy verwenden muss aktiviert und der Proxy-Host eingegeben werden.  

Die Geodaten des WMS können dann unter Themen hinzufügen importiert werden.  

In dem Menü muss WMS gewählt und danach die URL eingegeben werden. Es können 

das Referenzsystem, das Bildformat und eine mögliche Transparenz des Bildes gewählt 

werden (siehe Abb. 9). 

 

 
            Abb. 9: Menu zum Importieren eines WMS-Dienstes 

 

Die Möglichkeit der Nutzung eines WFS-Servers ist beim Spatial Commander nicht 

vorhanden. 
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2.2.10 Druckfunktionalität 

 

Die Druckfunktion des Spatial Commanders befindet sich unter dem Reiter Datei > 

Druckvorlage.  

In diesem Menü können Textelemente (Überschriften), Maßstabsleiste, Legende und 

Kartenfenster definiert werden (siehe Abb. 10). 

 

 
           Abb. 10: Einstellungsmöglichkeiten zum Druck 

 

Nach dem Bearbeiten der einzelnen Komponenten, die auf dem Ausdruck erscheinen 

sollen, kann das Ergebnis unter Vorschau begutachtet werden. Zusätzlich können jeweils 

Farbe, Rahmen, Position und Text der einzelnen Komponenten festgelegt werden. 

Leider kann die Position der einzelnen Komponenten nicht mit der Maus platziert, 

sondern nur numerisch eingegeben werden (siehe Abb.11). Das ist für den Benutzer sehr 

umständlich und erfordert vorab Berechnungen, um die Komponenten auf einander 

abzustimmen. 

Unter dem Feld Vollständig sind alle Komponenten durch einen Haken aktiviert (siehe 

Abb.10). Dieser lässt sich nicht entfernen. Das ist dann problematisch, wenn nicht alle 

Kartenkomponenten auf dem Ausdruck erscheinen sollen. 

 

 
  Abb. 11: Positionsangabe des Kartenfensters 
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Sinnvoller wäre es, die Kartenkomponenten in der Vorschau mit der Maus platzieren und 

deren Größe bestimmen zu können. 

Es kann zusätzlich zu DIN A4 noch in DIN A3 gedruckt werden. Es muss das Karten-

fenster auf diese Größe eingestellt werden. Zunächst unter dem Reiter Position (siehe 

Abb. 11). Aber auch bei Papiergröße, die man über den Button Drucken erreicht, sind 

hier iso-a4 oder iso-a3 einzustellen. 

Wenn der Ausdruck auf einen bestimmten Maßstab ausgelegt sein soll, muss der ge-

wünschte Maßstab erst unterhalb des Anzeigefensters eingestellt werden. 

 

 

2.2.11 Schreiben von Vektordaten 

 

Hier können Vektordaten als Shape-Datei  exportiert werden. DXF- oder GML-Dateien 

werden nicht geschrieben. 

Unter dem Reiter Thema > Thema speicher unter… befindet sich das Menü zum 

Schreiben von Shape-Dateien (siehe Abb. 12). Es besteht die Option, das Thema als 

Datei zu speichern oder die Tabelle in einer Datenbank abzulegen. 

 

 
            Abb. 12: Menu für das Schreiben von Shape-Daten 

 

Will man nur ausgewählte Elemente eines Themas exportieren, so müssen die gewünsch-

ten Objekte zuerst selektiert und ein Haken im Menü unter Nur selektierte Elemente spei-

chern gesetzt werden. Danach sind der Speicherort und der Name der Datei anzugeben. 

 

 

2.2.12 Schreiben von Bildern 

 

Das Schreiben von Bildern ist nicht möglich. 
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2.2.13 Schreiben von georeferenzierten Rasterdaten 

 

Auch die Möglichkeit zum Schreiben von georeferenzierten Rasterdaten ist nicht 

vorhanden. 

 

 

2.2.14 Fazit 

 

Der Spatial Commander 1.0.7-0 dient nicht nur dem reinen Viewing von Geodaten. Seine 

Menüführung ist klar strukturiert mit grafisch ansprechenden Benutzeroberflächen. Es 

bedarf keiner großen Einarbeitungszeit, da sich das Programm von selber erklärt. Die 

grafische Ausprägung der Geodaten ist für das Viewing gut geeignet. Zusätzlich können 

Arbeiten, wie dem Geoprozessing, der Digitalisierung, das Nutzen von WMS-Diensten, 

erfolgreich erledigt werden. Die Performance ist auch zufrieden stellend. Nur für das 

Drucken der Daten würde ich ein anderes Programm empfehlen, da das Platzieren der 

einzelnen Kartenkomponenten recht aufwendig ist. Es können Shape-Daten geschrieben 

werden, aber keine Bilder. 

 

Der Spatial Commander 1.0.7-0 erreicht insgesamt 67 Punkte in der Gesamtbewertung. 
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2.3 gvSIG 1.9 

 

2.3.1 Benutzeroberfläche 

 

Die Benutzeroberfläche des gvSIG ist nicht in allen Bereichen optimal gelungen. Die 

Icons sind zu klein und nicht immer einwandfrei interpretierbar (siehe Abb. 13). 

 

 
Abb. 13: Benutzeroberfläche des gvSIG  1.9 

 

Die Sprache der Benutzeroberfläche ist deutsch. Insgesamt wurde die Benutzeroberfläche 

mittelmäßig bewertet. 

 

 

2.3.2 Lesen von Vektordaten 

 

Nach dem Laden des Programms öffnet sich zunächst der Projektverwalter. Hier kann der 

Dokumenttyp festgelegt werden. Es stehen Ansicht, Tabelle und Karte zur Verfügung.  

Die Ansicht muss gewählt werden, um Geodaten importieren und editierten zu können. 

Es handelt sich dabei um den gewohnten Arbeitsbereich mit Anzeigefenster und der 

Themenleiste (siehe Abb. 13).  
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Unter Tabelle können Attributtabellen entweder aus einer Datei oder aus einer Datenbank 

importiert werden.  

Der Abschnitt Karte beschäftigt sich mit dem Präsentationsmodus der Geodaten. Hier 

können gespeicherte Karten samt Legende und Maßstabsleiste für die Ausgabe geöffnet 

werden. 

Die Software gvSIG liest das Shape- , das DXF-, als auch das GML 2.x- (2.1.2) Format. 

GML in der Version 3.x (3.1.1) wird nicht unterstützt. 

Auffällig ist, dass beim Importieren von Vektordaten alle Geometrien der Themen diesel-

ben Farben besitzen (siehe Abb. 13; links in der Themenleiste). Gewöhnlich wird beim 

Öffnen jedem Thema eine andere Farbgebung zugewiesen, um eine bessere Unterschei-

dung der Geoobjekte zu ermöglichen. 

 

 

2.3.3 grafische Ausprägung der Vektordaten 

 

Das Menü mit den Themeneigenschaften kann über einen Doppelklick auf das Thema 

geöffnet werden. 

Die Transparenz kann man über einen Schieberegler für Flächen bestimmen. Zusätzlich 

können aber auch Linien transparent dargestellt werden. 

Es stehen verschiedene Darstellungsarten für ein Thema zur Auswahl. Zum einen das 

Einheitssymbol, welches als Einheitliche Symbolik bezeichnet wird. Des Weiteren gibt es 

den Einzelwert, der als Einmalige Werte definiert wird. Das Zusammenfassen einzelner 

Werte in Klassen (Wertebereich) findet man unter dem Begriff Intervalle. Hier ist das 

Klassifikationsfeld, der Intervalltyp (gleiche, natürliche und quantile Intervalle), die 

Klassenanzahl und jeweils eine Farbe für die erste und letzte Klasse, zu wählen. Für die 

Klassen dazwischen werden die Farben interpoliert. 

Es können auch die Darstellungsmethoden Punktdichte, abgestufte Symbole und propor-

tionale Symbole gewählt werden. Zusätzlich gibt es den Bereich Ausdrücke, bei dem man 

die Werte eines Themas bezüglich eines Filters visualisieren kann. 

Es können Muster für Flächen, unterschiedliche Linienarten und verschiedene Punktsym-

bole eingestellt werden. 

Die Geometrieobjekte können mit Hilfe von Labels beschriftet werden. 

Die Benutzerfreundlichkeit wurde mit mittelmäßig bewertet. 

 

 

2.3.4 Lesen von georeferenzierten Rasterdaten 

 

Die Sofrware gvSIG liest sowohl das GeoTIFF, als auch Bildformate mit dem Worldfile als 

Anhang: TIFF (tfw), JPG (jgw), PNG (pgw) und GIF (gfw). 
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2.3.5 grafische Ausprägung der Rasterdaten 

 

Die grafische Ausprägung der Rasterbilder kann über einen Rechtsklick auf das Thema 

Eigenschaften des Rasterbildes geändert werden.  

Die Transparenz kann für das gesamte Bild über einen Schieberegler eingestellt werden.  

Auch einzelne Farbwerte können transparent geschaltet werden. 

Eine farbliche Veränderung von einzelnen Farbwerten ist nicht möglich.  

Der gvSIG kann im Gegensatz zu den anderen GIS-Viewern die Helligkeit der Raster- 

bilder beeinflussen. 

Auch dieses Menü wurde mit einem mittelmäßig bewertet. 

 

 

2.3.6 geografische Abfragen 

 

Die Attributtabelle wird über das Icon in der Menuleiste geöffnet. 

Die attributiven Abfragen mit SQL können über das Icon Filter gestartet werden.  

Der Tabellen-Join wird über das Icon Verbindung bei aktivierter Tabelle durchgeführt. 

Dabei muss jeweils bei der Original-, sowie der Zieltabelle die Spalte, mit der die Tabel-

len zu verbinden sind, ausgewählt werden. Zusätzlich zu der Join-Funktion gibt es noch 

den Tabellen-Link. Dabei bleiben beide Tabellen bestehen, die Datensätze sind jedoch 

miteinander verknüpft. 

Das Menü zu den räumlichen Abfragen kann über das Icon Geoprozessmanager in der 

Menüleiste geöffnet werden. Hier sind die einzelnen Funktionen anhand von Abbildungen 

und Beschreibungen gut erklärt.  

Für die Pufferfunktion ist es erforderlich, das Objekt, um welches ein Puffer gebildet 

werden soll, zu selektieren. Anschließend muss der Radius und die Einheit (Meter, 

Kilometer usw.) gewählt werden. Zusätzlich gibt es weitere Bedingungen (Puffer inner-

halb oder außerhalb des Objektes usw.), die bestimmt werden können. 

Außer der Funktion sind die Operatoren Intersect, Union und Merge vorhanden. Die 

Dissolve-Funktion ist nicht gegeben. 

 

 

2.3.7 Performance 

 

Vektor 

Der gvSIG war bei allen drei Untersuchungen auffallend positiv. Hier gab es durchwegs 

ein gutes Ergebnis. Vor allem sind die Wartezeiten beim Öffnen der Attributtabelle und  
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den attributiven Abfragen sehr gering. Wo andere Viewer gerade bei den Abfragen mit  

einer Dateigröße von 144 MB in die Knie gehen ist der gvSIG erstaunlich schnell. 

 

 27 MB 83 MB 144 MB 
Lesen ●● ●● ●(●) 
Zoom ●● ●● ● 
Verschieben ● ●  ● 
Symbolik ändern ●● ● ● 
Tabelle öffnen ●● ●● ●● 
attributive Abfrage ●● ●● ●● 
Ergebnis ●● ●● ●● 
Tabelle 5: Vektorperformance des gvSIG 1.9 

 

 

Raster 

Die Rasterperformance beim gvSIG fällt in dem Test mit 85 MB gut aus. Die beiden wei-

teren Untersuchungen ergeben eine mittelmäßige Bewertung. 

 

 85 MB 263 MB 577 MB 
Lesen ● ● ● 
Zoom ●● ●● ●(●) 
Verschieben ●(●) ● ● 
Transparenz ●● ●(●) ●(●) 
Ergebnis ●● ● ● 
Tabelle 6: Rasterperformance des gvSIG 1.9 

 

 

2.3.8 Digitalisierung 

 

Ein neues Thema für das Digitalisieren kann unter dem Reiter Ansicht > Neuer Layer > 

Neue Shape-Datei erstellt werden.  
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         Abb. 14: Erstellen eines neuen Themas 

 

Hier kann man den Namen des Themas und den Geometrietyp festlegen (siehe Abb. 14). 

Danach müssen die Felder der Attributtabelle und die Projektion bestimmt werden. 

Anschließend kann mit der Digitalisierung beginnen.  

Die Zeichenfunktionen befindet sich in der Menüleiste. Hier können Punkte, Linien und 

Flächen erzeugt werden. Die Geometrien kann man auch verschieben, kopieren, spiegeln, 

drehen und skalieren. Zusätzlich ist ein Bearbeiten der Stützpunkte möglich. Die Bear-

beitungsschritte können auch jederzeit wieder rückgängig gemacht werden.  

Die Merkmale zu den Objekten kann man in die Attributtabelle eingefügen. 

Der Abschnitt 2.3.11 (Schreiben von Vektordaten) beschäftigt sich mit dem Speichern 

dieser neu entstandenen Geometrien. 

 

 

2.3.9 WMS-/WFS-Dienste 

 

Bevor ein WMS-/WFS-Layer geladen werden kann, müssen die Einstellungen über das 

entsprechende Icon in der Menüleiste geöffnet werden. Unter Internet > Firewall/Proxy 

sind der Proxy-Server und der Proxy-Port einzugeben. 

Danach kann man, wie gewohnt, über das Icon Layer hinzufügen die Daten des WMS-

Servers abrufen. Zunächst erhält man eine Übersicht über die Metainformationen des 

Rasterbildes, anschließend muss das Bildformat gewählt werden. 

Der Import eines WFS-Layers erfolgt über den Reiter WFS im Menü Layer hinzufügen. 

Nach den Metadaten (Server, Servertyp usw.) können die zur Verfügung stehenden 

Themen aktiviert werden.  



 44 

Mit Hilfe eines Filters man eine Vorauswahl treffen oder einen bestimmten Bereich defi-

nieren. 

Der Viewer gvSIG hat eine Schnittstelle für den WFS-Import von GML in der Version 2.x, 

nicht aber 3.x. 

 

 

2.3.10 Druckfunktionalität 

 

Das Menü zum Druck wird unter dem Reiter Ansicht > Druck zur Info geöffnet. In dem 

Fenster können zunächst das Format, die Anzahl der Kopien, die Ausrichtung und 

mehrere Optionen (Bsp.: Legende anzeigen) festgelegt werden.  

Wählt man nun die Vorschau, so öffnet sich ein Fenster, in dem alle Komponenten des 

Ausdruckes bestimmt werden können (siehe Abb. 15). 

 

 
       Abb. 15: Druckvorschau 
 

Über die Menüleiste können Textfelder, Bilder, Maßstabsleisten sowie ein Gitternetz und 

die Legende erstellt werden.  

Außerdem ist eine Gruppierung der grafischen Komponenten möglich.  

Position und Größe der Grafiken können mit der Maus festgelegt werden.  

Gedruckt werden kann auf die Papierformate DIN A4 und DIN A3. 
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Es kann auch der zu druckende Maßstab unter Einstellung zur Druckinfo, Maßstab 

definieren festgelegt werden. 

 

 

2.3.11 Schreiben von Vektordaten 

 

Der gvSIG kann alle in die Untersuchung eingehenden Vektorformate Shape, DXF und 

GML schreiben. Die Version des geschriebenen GML ist 2.1.2.  

Zusätzlich gibt es noch die Möglichkeit, die Vektoren als PostGIS, KML und in einen 

Beschriftungslayer, zu exportieren. Diese Auswahlmöglichkeiten findet man unter dem 

Reiter Layer > Exportieren nach….  

 

 

2.3.12 Schreiben von Bildern 

 

Es können Bilder der dargestellten Geodaten im JPG-, PNG- und Bitmap-Format unter 

dem Reiter Ansicht > Exportieren > Bild gespeichert werden. 

Die Formate TIFF und GIF sind nicht vorhanden. 

 

 

2.3.13 Schreiben von georeferenzierten Rasterdaten 

 

Um ein georeferenziertes Bild zu speichern muss das Icon Rasterlayer in der Menüleiste 

auf Raster exportieren umgestellt werden. Daraufhin sind über das Icon rechts daneben 

andere Funktionen vorhanden. Mit Hilfe des roten Rechtecks Bereich der Ansicht als 

georeferenziertes Bild speichern kann jetzt der Ausschnitt gewählt werden. Danach öffnet 

sich ein Menü (siehe Abb.16).  
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    Abb. 16: Rasterexport 
 

Hier kann man nun die Koordinaten auf der Erdoberfläche ändern. Zusätzlich können 

Maßstab, Bodenauflösung und Größe des zu erzeugenden Bildes bestimmt werden. Für 

diesen Test habe ich einen Ausschnitt aus einer DTK 25 erstellt. Die Bodenauflösung 

beträgt 2,5 Meter/Pixel. Danach werden über den Button Auswahl der Speicherort und 

das Dateiformat bestimmt. Jetzt ist der Button Eigenschaften aktiv, unter dem man nun 

für das jeweilige Format bestimmte Einstellungen vornehmen kann. Als Beispiel können 

bei TIFF die Kompremierungsart, bei JPG die Kompressionsstärke eingestellt werden. 

Ein GeoTIFF kann erzeugt werden, wenn bei den Eigenschaften kein Haken bei tfw 

gesetzt wird. Ist der Haken aktiv, so wird zusätzlich zu dem Rasterbild ein World-File 

(tfw) geschrieben. Außerdem stehen noch die Formate JPG- (jgw) und PNG- (pgw) zur 

Verfügung. Ein GIF (gfw) ist nicht zu erstellen. 

Zusätzlich stehen noch weitere Rasterfunktionen zur Verfügung. Unter Rasterlayer kann 

man sich das Histogramm, eine Farbtabelle anzeigen und Pyramiden erzeugen lassen. 

Über Ansicht zu Analyse öffnet sich ein Detailfenster in dem die Farbwerte an der Stelle 

des Cursors angezeigt werden. Die Funktion Rasterprozesse beinhaltet eine 

Vektorisierung, einen Filter mit unterschiedlichen Operatoren und eine radiometrische 

Verbesserung. Die Geographische Transformation ermöglicht das Georeferenzieren und 

das Umprojizieren von Bildern.  
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2.3.14 Fazit 

 

Das Programm gvSIG 1.9 sticht in allen Bereichen heraus. Fast jedes Untersuchungs-

kriterium wurde hervorragend erfüllt. Kleinigkeiten, wie beispielsweise dem nicht unter-

stützten Import von GML-Dateien der Version 3.x gehen bei dem breiten Einsatzspek-

trums des gvSIG 1.9 unter. Es ist aber zu erwähnen, dass man sich etwas Zeit nehmen 

muss, um sich in die Software einzuarbeiten. Es erklärt sich nicht auf Anhieb alles von 

selbst. 

 

Die Software gvSIG 1.9 erreicht mit 82,5 Punkten das beste Gesamtergebnis. 
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2.4 Quantum GIS 1.4.0 

 

2.4.1 Benutzeroberfläche 

 

Die Benutzeroberfläche enthält zwar eine Menge Icons in der Menuleiste, ist aber trotz-

dem recht übersichtlich. Die Icons haben eine angenehme Größe und sind gut inter-

pretierbar. Die Leiste mit den Themen befindet sich links von dem Anzeigefenster. Der 

Maßstab und die Koordinaten werden unterhalb angezeigt. 

 

 
Abb. 17: Benutzeroberfläche des Quantum GIS 1.4.0 

 

Die Benutzeroberfläche ist grafisch sehr ansprechend, übersichtlich und wurde gut 

bewertet. Die Sprache ist deutsch.  

 

 

2.4.2 Lesen von Vektordaten 

 

Zum Importieren von Vektordaten gibt es ein eigenes Icon in der Menüleiste. Dann muss 

gewählt werden, ob man eine Datei, einen kompletten Ordner oder eine Datenbank  

 



 49 

importieren möchte. 

Quantum GIS liest Shape-Files und GML-Dateien in der Version 2.x und 3.x. Beim Import 

von GML können sogar, sofern vorhanden, die einzelnen Unterlayer ausgewählt werden 

(siehe Abb. 18). Für den Test habe ich aus einem ATKIS-Shape eine GML-Datei erzeugt. 

Dabei wurden alle 13 Objektklassen in eine Datei geschrieben. Nun können im Quantum 

GIS die gewünschten Layer ausgewählt werden. 

 

 
                 Abb. 18: Wahl der Themen bei GML 

 

DXF-Dateien können nicht gelesen werden, aber das Programm enthält eine Funktion, 

um DXF- in Shape-Files umzuwandeln. Dabei ist zu beachten, dass Punkte, Linien und 

Polygone als einzelne Shape-Dateien umgewandelt werden müssen. D.h., enthält ein DXF 

Punkte, Linien und Flächen so werden drei Shapes benötigt, um alle Objekte visualisieren 

zu können. 

 

 

2.4.3 grafische Ausprägung der Vektordaten 

 

Die Themeneigenschaften werden über einen Doppelklick auf das Thema oder über den 

Menüpunkt Layer > Eigenschaften geöffnet. Die grafische Ausprägung ist über den Reiter  
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Darstellung erreichbar.  

Die Transparenz kann über einen Schieberegler für Flächen definiert werden.  

Es besteht sogar die Möglichkeit, Punkte und Linien transparent darzustellen. 

Die Darstellungsmöglichkeiten der Objekte bestehen aus: Einzelsymbol, welches dem 

Einheitssymbol entspricht (siehe Abb. 19), abgestuftes Symbol, das den Wertebereich 

(Klassenbildung) wiedergibt und eindeutiger Wert, der die Bezeichnung für den Einzel-

wert ist. Zusätzlich gibt es noch die Funktion Fortlaufende Farbe. Dabei wird das 

gewünschte Klassifikationsfeld, je nach numerischem Wert, zwischen einem Maximum 

und einem Minimum dargestellt. Hierfür ist jeweils eine Farbe für den maximalen und 

eine für den minimalen Wert auszuwählen. Zwischen diesen beiden Extremwerten 

werden dann die Farben interpoliert. 

 

 
        Abb. 19: Darstellungsmöglichkeiten für Einzelsymbol 

 

Die Farben können aus einer voreingestellten Palette, oder über einen Farbmischer mit 

Hilfe des RGB-, bzw. HSB-Farbraumes gewählt werden (siehe Abb. 20) 

Für Polygone kann man Muster, für Linien Linienarten (Umrandungsstil) und für Punkte 

unterschiedliche Symbole bestimmen.  

Es besteht keine Möglichkeit, benutzerdefinierte Punktsymbole zu importieren. 

Zusätzlich können hier auch Objekte beschriftet werden.. 

Das Menü wurde gut bewertet. 
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                Abb. 20: Farbwahl durch einen Farbmischer  

 

 

2.4.4 Lesen von georeferenzierten Rasterdaten 

 

Wie beim Öffnen der Vektordaten in Abschnitt 2.4.2, ist auch für die Einbindung von 

Rasterdaten ein eigenes Icon vorhanden. 

Das Programm liest alle georeferenzierten Rasterformate, die in den Test miteinbezogen 

wurden: GeoTIFF, TIFF mit tfw, JPEG mit jgw, PNG mit pgw und GIF mit gfw. 

 

 

2.4.5 grafische Ausprägung der Rasterdaten 

 

Die Eigenschaften der Rasterbilder können über einen Doppelklick auf das Thema, oder 

über Layer > Eigenschaften aufgerufen werden. 

Die Transparenz kann man über den Reiter Transparenz mit einem Schieberegler 

steuern.  

Die einzelnen Farbwerte können unter dem Reiter Farbkarte verändert oder transparent 

(keine Farbe) geschalten werden.  

Die Helligkeit der Rasterdaten ist nicht zu beeinflussen. 

Es besteht aber die Möglichkeit, ein Histogramm und die Pyramidenstufen anzeigen zu 

lassen. 

Auch dieses Menü erhielt die Bewertung gut. 
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2.4.6 geografische Abfragen 

 

Die Attributtabelle kann man entweder über das Icon in der Menuleiste, durch einen 

Rechtsklick auf das Thema, oder über den Reiter Layer > Attributtabelle öffnen aufrufen. 

Auch hier gibt es Funktionen, wie das Verschieben der ausgewählten Sachdaten an den 

Tabellenanfang, oder das Umkehren der Auswahl.  

Der Bearbeitungsmodus muss aktiviert sein, um die Daten verändern zu können. 

Über den Button Erweiterte Suche gelangt man zum Query Builder, mit dem man 

attributive Abfragen mit Hilfe von SQL durchführen kann. 

Der Tabellen-Join befindet sich unter dem Reiter Vektor > Datenmanagement Werkzeuge 

> Attribute zusammenführen (siehe Abb. 21). 

 

 
                    Abb. 21: Tabellen-Join 

 

Bei dieser Funktion des Join’s kann man wählen, ob die Geometrien über die Merkmale 

verknüpft und in ein neues Shapefile geschrieben, oder nur die Tabellen zusammen-

geführt werden sollen. 

Bei den räumlichen Abfragen fehlt nur die Funktion Merge.  
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Das Menü zu den räumlichen Abfragen findet man unter Vektor > Geoverarbeitungs-

werkzeuge. Hier wird der Operator Dissolve als Auflösen, Intersect als Schnittmenge und  

Union als Vereinigung bezeichnet. 

Es beschreibt weder ein Text, noch eine Abbildung die einzelnen Funktionen. 

  

 

2.4.7 Performance 

 

Vektor 

Im Gegensatz zum gvSIG ist der Quantum GIS das negative Beispiel in der Performance.  

Zwar war die erste Testserie sehr zufriedenstellend mit einem guten Ergebnis, doch das 

konnte das Programm nicht halten. Beim Arbeiten mit den Dateigrößen 83 MB und 144 

MB war die Grenze schnell erreicht. Bei den attributiven Abfragen waren die Wartezeiten 

schon sehr lange. Es erscheint mir nicht sinnvoll, Daten solcher Größe mit dem Quantum 

GIS zu verarbeiten. Das Ergebnis belief sich im zweiten und dritten Test auf schlecht. 

 

 27 MB 83 MB 144 MB 
Lesen ●● ● ● 
Zoom ●● ● (●) 
Verschieben ●● ● (●) 
Symbolik ändern ●● (●) (●) 
Tabelle öffnen ●● ● ● 
attributive Abfrage ● - - 
Ergebnis ●● - - 
Tabelle 7: Vektorperformance des Quantum GIS 1.4.0 

 

 

Raster 

Der Viewer QGIS schneidet bei den Rasterdaten im Gegensatz zu der Vektorperfor-mance 

besser ab. Die ersten beiden Untersuchungen ergaben eine gute Beurteilung. Der dritte 

Test mit 577 MB ist mittelmäßig. 

 

 85 MB 263 MB 577 MB 
Lesen ●● ●(●) (●) 
Zoom ●● ●● ●(●) 
Verschieben ●(●) ● ● 
Transparenz ●● ●● ●(●) 
Ergebnis ●● ●● ● 
Tabelle 8: Rasterperformance des Quantum GIS 1.4.0 
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2.4.8 Digitalisierung 

 

Ein neues Thema für die Digitalisierung kann unter dem Reiter Layer > Neuer Vektorlayer 

erstellt werden. In diesem Menü kann man zunächst den Geometrietyp (Punkt, Linie oder 

Fläche) und die Projektion einstellen. Nun können die Felder der Attribute definiert 

werden. Dazu gehören die Bezeichnung des Feldes und der Attributtyp (Text, Ganzzahl 

oder Dezimalzahl). Nach dem Bestätigen ist der Speicherort zu wählen. Nachdem das 

Thema angelegt ist, muss der Bearbeitungsmodus gestartet werden, um mit der Digitali-

sierung beginnen zu können. Es können nun je nach gewähltem Geometrietyp Punkte, 

Linien oder Flächen gezeichnet werden. Zusätzlich besteht die Möglichkeit, Geometrien zu 

verschieben, trennen und deren Stützpunkte zu bearbeiten. Bei Flächen können Inseln 

und Ringe (zusätzliche Flächen in der Fläche) erzeugt werden. Eine Vereinfachung der 

Objekte ist möglich, sowie das Rückgängigmachen der Arbeitsschritte. Nach dem Aus-

schalten des Bearbeitungsmodus kann die Geometrie gespeichert werden. 

 

 

2.4.9 WMS-/WFS-Dienste 

 

Der WMS-Dienst kann über das Icon WMS-Layer hinzufügen angesprochen werden.  

In dem Menü kann man nun unter Neu eine URL angeben und speichern. Dann greift 

man über den Button Verbinden auf den Server zu. Danach sind Bildformat und Projek-

tion wählbar. 

Ähnlich verhält es sich beim Importieren eines WFS-Layers. Auch hier gibt es ein eigenes 

Icon in der Menüleiste. 

Das Programm QGIS besitzt eine Schnittstelle für den WFS-Import von GML in den 

Versionen 2.x und 3.x. 

 

 

2.4.10 Druckfunktionalität 

 

Zu der Funktion Druck (siehe Abb. 22) gelangt man über das Icon Neue Druckzusam-

menstellung in der Menüleiste.  
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             Abb. 22: Druckvorschau 

 

Zunächst muss über den Button Neue Karte hinzufügen der Platzhalter des Karten-

fensters bestimmt werden. Danach erscheint die Kartengrafik in der Druckvorschau.  

Textfelder, Legende und Maßstabsleiste kann man nun erzeugen. Dazu muss jeweils das 

richtige Icon in der Menüleiste gedrückt und ein Rechteck auf dem Layout aufgezogen 

werden. Unter dem Reiter Eintrag sind die einzelnen Komponenten dann zu bearbeiten. 

Die einzelnen Kartenkomponenten werden mit der Maus platziert und es besteht die 

Möglichkeit einer Gruppierung und einer automatischen Anordnung. 

Der Ausdruck ist in DIN A4 und DIN A3 möglich. 

Um einen bestimmten Maßstab zu drucken, muss vorher unter dem Anzeigefenster der 

Maßstab eingegeben werden. Dazu ist unter Einstellungen > Projekteinstellungen > 

Allgemein die richtige Maßeinheit Meter einzustellen. Leider funktioniert die Maßstabsleis-

te in der Druckzusammenstellung nicht. Lässt man die Einheiten, wie in der Grundein-

stellung auf dezimale Grad, erscheint eine Maßstabsleiste. 

Der Druck in einem bestimmten Maßstab stimmt nicht. Je nach der Formatgröße DIN A4  
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oder DIN A3 werden die abgebildeten Objekte skaliert. 

Es ist noch zu erwähnen, dass mir das Programm bei der Druckzusammenstellung 

abgestürzt ist. 

 

 

2.4.11 Schreiben von Vektordaten 

 

Vektordaten können nur im Shape-Format gespeichert werden. Unter dem Reiter Layer 

besteht die Möglichkeit, ein komplettes Thema (es muss markiert sein) über den Befehl 

als Shape-Datei speichern…, oder nur einzelne selektierte Objekte eines Themas über 

den Befehl Auswahl als Shape-Datei speichern… zu schreiben.  

Vektoren in DXF- oder GML-Dateien können nicht exportiert werden.  

 

 

2.4.12 Schreiben von Bildern 

 

Der Inhalt des Anzeigefensters kann als Bild unter dem Reiter Datei > Bild speichern als… 

geschrieben werden. Zur Auswahl stehen die Formate: TIFF, JPG, PNG, GIF und BMP.  

Jedoch ist das Bild nach dem Speichern als JPG schwarz.  

Bei der Wahl eines GIF’s wird nur das World-File, nicht aber die Bilddatei geschrieben. 

Zusätzlich zu den Rasterdaten wird das World-File geschrieben (siehe Abschnitt 2.4.13 

Schreiben von georeferenzierten Rasterdaten). 

 

 

2.4.13 Schreiben von georeferenzierten Rasterdaten 

 

Wie im Abschnitt 2.4.12 (Schreiben von Bildern) wird zusätzlich zu der Bilddatei noch ein 

World-File gespeichert, das die Lage der linken oberen Ecke des Bildes festlegt.  

Wie im vorherigen Abschnitt (2.4.12 Schreiben von Bildern) schon erwähnt, ist das GIF-

Bild nicht vorhanden und das JPG-Bild enthält keine Information. 

Ein GeoTIFF kann nicht erzeugt werden. 

 

 

2.4.14 Fazit 

 

Das Programm Quantum GIS 1.4.0 besitzt eine gute Benutzeroberfläche und eine über-

schaubare Menüführung. Auch die Funktionen sind in Ordnung. Aufgaben, wie dem Geo-

prozessing, dem Digitalisieren und Drucken ist der QGIS gewachsen. Positiv ist noch zu  
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sagen, dass die Nutzung von Webdiensten (vor allem des WFS) mit diesem Programm 

am erfreulichsten von allen war. Der Import von GML 3.x wird hier unterstützt. Negativ 

anmerken muss man die schwache Performance bei Vektordaten. 

 

Quantum GIS 1.4.0 erhält eine Gesamtpunktzahl von 76,1. 
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2.5 uDIG 1.1.1 

 

2.5.1 Benutzeroberfläche 

 

Die Benutzeroberfläche des uDIG 1.1.1 ist recht gut gelungen und in deutscher Sprache.  

Die Icons in der Menüleiste könnten manchmal etwas größer sein und sind nicht immer 

sofort zu erkennen. Dennoch sind sie übersichtlich und nicht zu zahlreich. Links vom An-

zeigefenster befindet sich die Themenübersicht. Unterhalb werden der Maßstab, die 

Projektion und die Koordinaten angezeigt. 

 

 
Abb. 23: Benutzeroberfläche von uDIG  1.1.1 

 

Zusätzlich ist darunter noch eine Auswahl, in der sich der Katalog, der Webbrowser, eine 

Suchfunktion, eine Fortschrittsleiste bei Operationen und eine Informationskonsole 

befinden. Auch die Attributtabelle wird hier angezeigt, was am Anfang etwas ungewohnt 

ist.  Die Tabelle kann je nach Gebrauch vergrößert oder verkleinert angezeigt werden. 

Die Benutzeroberfläche ist mittelmäßig bewertet. 
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2.5.2 Lesen von Vektordaten 

 

uDIG liest Shape-, jedoch keine DXF-, und GML-Dateien.  

Laut Importliste sollten GML-Daten auch gelesen werden können. Doch nach dem Öffnen 

werden die Daten nicht visualisiert. 

 

 

2.5.3 grafische Ausprägung der Vektordaten 

 

Die Symbolik der Vektordaten kann entweder über das Farbpaletten-Icon oberhalb der 

Themenleiste, über einen Rechtsklick auf das Thema Stil ändern… oder im Menu über 

Layer > Stil ändern… definiert werden. 

Für Punkte, Linien und Flächen kann eine Transparenz mit Hilfe von Prozentwerten 

numerisch eingestellt werden. Hier ist zu beachten, dass die Zahl nicht die Transparenz, 

sondern die Dichte angibt (siehe Abb. 24). So wird zum Beispiel für eine 30 prozentige 

Transparenz ein Wert von 70 Prozent benötigt.  

Die Darstellungsmöglichkeiten der Vektordaten beschränken sich auf Einfach (siehe Abb. 

24), was dem Einheitssymbol entspricht, und Thematisch, bei dem ein Wertebereich 

(Klassenbildung) erstellt werden kann.  

Bei der Klassenbildung müssen das Attributfeld, die Klassenanzahl und die Art der Inter-

vallgrenze (gleiches Intervall oder Quantile) gewählt werden. 

Die Funktion des Einzelwertes ist hier nicht vorhanden. 

 

 
    Abb. 24: Darstellungsmöglichkeit Einfach 
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Die Farben können über einen Farbmischer bestimmt werden. 

Muster für Flächen und unterschiedliche Linienarten sind nicht wählbar, aber es gibt 

verschiedene Punktsymbole (Bsp.: Kreis, Quadrat, Dreieck…).  

Benutzerdefinierte Punktsymbole kann man nicht importieren.  

Es besteht die Möglichkeit, die eingestellte Symbolik als SLD-Datei zu speichern und zu 

importieren. 

Zusätzlich können die Objekte automatisch über die Wahl eines Attributes beschriftet 

werden. 

Die Benutzerfeundlichkeit bei der grafischen Ausprägung von Vektordaten ist nicht 

besonders ansprechend und ist somit mittelmäßig bewertet.   

 

 

2.5.4 Lesen von georeferenzierten Rasterdaten 

 

Die Rasterdaten können analog zu den Vektordaten geladen werden. Es werden alle  

Bildformate, die mit Hilfe des World-File in das Koordinatensystem eingebunden sind, 

gelesen. TIFF (tfw), JPG (jgw), PNG (pgw) und GIF (gfw).  

Einzig das GeoTIFF kann nicht gelesen werden. 

Es ist darauf zu achten, dass die Projektion richtig eingestellt ist, sonst erscheinen die 

Rasterbilder verzerrt. Für die Daten, die in dieser Untersuchung benutzt werden, ist 

folgende Projektion zu wählen: DHDN (Deutsches Hauptdreiecksnetz) GK (Gauß Krüger) 

Zone 4. 

 

 

2.5.5 grafische Ausprägung der Rasterdaten 

 

Die grafischen Darstellungsmöglichkeiten des uDIG bei Rasterdaten ist sehr begrenzt 

(siehe Abb. 25). Es besteht lediglich die Möglichkeit eine Transparenz für das gesamte 

Bild einzustellen. Das kann entweder in den eingestellten Stufen (0%, 25%, 50%, 75% 

oder 100%) oder numerisch geschehen. Die Werte geben aber nicht die Transparenz, 

sondern die Dichte des Bildes wieder. 
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                     Abb. 25: Menu der grafischen Ausprägung der Rasterdaten 

 

Es können weder eine Transparenz für einzelne Farbwerte, noch die Farbwerte  bei 

Palettenbildern verändert werden. 

Auch eine Helligkeitseinstellung ist nicht möglich.  

Somit lässt das Eigenschaftsmenü der Rasterdaten einiges zu wünschen übrig. Die 

Benutzerfreundlichkeit erhält eine mittelmäßige Bewertung. 

 

 

2.5.6 geografische Abfragen 

 

Die Attributtabelle kann bei aktiviertem Thema durch das Tabellen-Icon unterhalb der 

Koordinatenanzeige geöffnet werden. Sie öffnet sich unterhalb des Anzeigefensters, was 

am Anfang sehr ungewohnt ist. 

Die attributive Abfrage erfolgt nicht durch die, wie sonst üblich, verwendete Datenbank-

sprache SQL, sonder durch CQL (Common Query Language). Diese entspricht aber SQL 

und kann wie gewohnt eingesetzt werden. Dazu muss in der linken Liste CQL markiert 

werden und rechts daneben die SQL-Abfrage selbstständig eingegeben werden. 

Eine Join-Funktion für Tabellen ist nicht vorhanden.  

Ebenso wenig können räumliche Abfragen durchgeführt werden. 

 

 

2.5.7 Performance 

 

Vektor 

Der uDIG verhielt sich bei den drei Tests relativ gleichmäßig. Das Ergebnis ist bei allen 

Testläufen mittel. Im dritten Test war das Verschieben des Ausschnitts und das Ändern 
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der Symbolik nicht mehr so optimal. Doch das Öffnen der Attributtabelle und die 

attributiven Abfragen waren recht erfreulich. 

 

 27 MB 83 MB 144 MB 
Lesen ● ● ● 
Zoom ●● ● ● 
Verschieben ●● ● (●) 
Symbolik ändern ● ● (●) 
Tabelle öffnen ●● ●● ●● 
attributive Abfrage ● ● ● 
Ergebnis ● ● ● 
Tabelle 9: Vektorperformance des uDIG 1.1.1 

 

 

Raster 

Von allen Programmen verhält sich der uDIG bei der Rasterperformance am schlechtes-

ten. Zwar ist das Ergebnis bei 85 MB gut, doch die die Untersuchungen mit 263 MB und 

577 MB fallen schlecht aus. Das Arbeiten mit Rasterdaten ist mit solchen Dateigrößen 

nicht mehr möglich, da die Wartezeiten extrem lange werden. 

 

 85 MB 263 MB 577 MB 
Lesen ● - - 
Zoom ●● - - 
Verschieben ●(●) - - 
Transparenz ●● - - 
Ergebnis ●● - - 
Tabelle 10: Rasterperformance des uDIG 1.1.1 

 

 

2.5.8 Digitalisierung 

 

Ein neues Thema wird über den Reiter Layer > Erstellen angelegt. Wie bei den anderen 

Programmen auch, müssen hier der Geometrietyp (Punkt, Linie, Fläche), die Bezeichnung 

des Feldes, der Datentyp (Integer, String usw.) und die Projektion definiert werden. 

Über die Zeichenfunktionen in der Menüleiste werden die gewünschten Geometrien er-

stellt. Auch hier können Stützpunkte verschoben, hinzugefügt und entfernt werden. 

Zusätzlich gibt es ein Lochwerkzeug, mit dem man aus einer Fläche etwas ausschneiden 

kann. Will man Arbeitsschritte rückgängig machen, so geht das über den Reiter 

Bearbeiten > Rückgängig. 

Das Speichern der Vektorendaten mit den Attributwerten wird im Abschnitt 2.5.11 

(Schreiben von Vektordaten) beschrieben. 
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2.5.9 WMS-/WFS-Dienste 

 

Um auf den WMS-Server zugreifen zu können, müssen zunächst folgende Einstellungen 

durchgeführt werden: In dem Programmordner uDig ist der Proxy-Host und Proxy-Port in 

der Datei uDig.ini zu definieren (siehe Abb. 26). 

 

 
    Abb. 26: Proxy Einstellungen  

 

Danach kann man über den Button Add Data > Web Map Server und einer URL die Layer  

eines WMS-Server importieren. 

Es ist auch ein Menü zur Nutzung eines WFS-Dienstes unter dem Button Add Data 

vorhanden. Der Server wird auch angesprochen. Die einzelnen Layer werden ausgewählt, 

jedoch am Bildschirm nicht dargestellt. Da die WFS-Dienste mit dem GML-Format arbei-

ten, kann hier das Problem liegen. Wie im Abschnitt 2.5.2 (Lesen von Vektordaten) schon 

erwähnt, werden GML-Daten nicht gelesen. 

 

 

2.5.10 Druckfunktionalität 

 

Das Druckmenü erreicht man über den Reiter Datei > Drucken…. Hier kann man nun eine 

Layout-Vorlage wählen: Standard für Hochformat oder Landschaft für Querformat. Es 

wird eine Vorschau der zu druckenden Karte erstellt. Die Palette an der rechten Seite 

enthält die einfügbaren Kartenkomponenten. Mit Bezeichnung kann man ein Textfeld 

aufziehen und unter Grafik können eine Legende, eine Maßstabsleiste und ein Gittenetz 

erstellt werden.  

Die Maßstabsleiste gibt jedoch den eingestellten Maßstab nicht korrekt wieder. 

Der Druck auf eine Formatgröße von DIN A3 ist nicht gegeben.  

Um einen  bestimmten Maßstab für den Druck einzustellen, muss man die rechte Maus-

taste auf dem Kartenausschnitt der Druckvorschau drücken und Maßstab setzen 

aktivieren. Der Maßstab ist jedoch nicht korrekt. 

Das Programm ist bei den Druckuntersuchungen mehrmals abgestürzt. 
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2.5.11 Schreiben von Vektordaten 

 

Es können Vektordaten als Shapefile geschrieben werden. Unter dem Reiter Exportieren 

> Kartenlayer als Shapefile exportieren ist ein Thema auszuwählen und zu speichern. 

Ein Export als DXF- oder GML-Datei ist nicht möglich. 

 

 

2.5.12 Schreiben von Bildern 

 

Der Kartenlayer, der alle dargestellten Themen präsentiert, kann über Datei > Expor-

tieren > Karte als Bild exportieren gespeichert werden.  

Zur Auswahl stehen die Formate: PDF, TIFF, GIF und PNG, aber kein JPG und BMP. 

Zusätzlich zu den Bildern werden weitere Dateien, welche die Georeferenzierung 

beinhalten, geschrieben (siehe Abschnitt 2.5.13 Schreiben von georeferenzierten 

Rasterdaten). 

 

 

2.5.13 Schreiben von georeferenzierten Rasterdaten 

 

Georeferenzierte Rasterdaten werden genauso geschrieben wie in Abschnitt 2.5.12 

(Schreiben von Bildern).  

Die zur Verfügung stehenden Rasterformate sind: TIFF, GIF und PNG. GeoTIFF und JPG 

sind in der Auswahl nicht vorhanden.  

Beim Schreiben entstehen zusätzlich zu den Rasterdateien zwei weitere Dateien. Die 

*.prj-Datei enthält die Projektion und das Erdellipsoid (siehe Abb. 27). 

 

 
Abb. 27: Inhalt der*.prj-Datei (geöffnet mit dem Editor) 
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Die zweite Datei ist mit *.wld benannt und entspricht dem Worldfile, welches die linke 

obere Ecke des Bildes festlegt.  

Ungewöhnlich ist hier die Bezeichnung *.wld, da der Datei ansonsten je nach Format nur 

ein w angehängt wird. Eine TIFF-datei nennt sich dann beispielsweise: *.tfw. 

 

 

2.5.14 Fazit 

 

Die Software uDIG 1.1.1 erfüllt den Zweck eines reinen Viewers. Er kann Shape-Dateien 

lesen, besitzt aber die Darstellungsmöglichkeit des Einzelwertes nicht. Für räumliche Ab-

fragen ist er nicht geeignet. Es können aber Vektoren digitalisiert und zumindest WMS-

Dienste genutzt werden. Vektordaten können im Shape-Format geschrieben werden und 

die Performance bei den Rasterbildern war schlecht. Für den Druck ist uDIG nicht geeig-

net, weil das Drucken in einem bestimmten Maßstab nicht möglich ist. 

 

Der Viewer uDIG 1.1.1 erhält 49,2 Punkte in der Gesamtbewertung. 
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2.6 Map Window 4.7.3 

 

2.6.1 Benutzeroberfläche 

 

Die Map Window 4.7.3 Benutzeroberfläche ist sehr übersichtlich und in deutscher 

Sprache. Die Icons in der Menüleiste sind groß genug und so gestaltet, dass sie eindeutig 

interpretiert werden können. Die benötigten Funktionen mit den dazugehörigen Icons 

können über den Button PlugIns selbständig verwaltet werden. Wie gewohnt, befindet 

sich die Themenleiste links neben dem Anzeigefenster. 

 

 
Abb. 28: Benutzeroberfläche von Map Window 4.7.3 

 

Die Benutzeroberfläche erhält eine gute Bewertung. 

 

 

2.6.2 Lesen von Vektordaten 

 

Map Window liest das Shape-Format, aber weder DXF- noch GML-Dateien. 

 

 



 67 

2.6.3 grafische Ausprägung der Vektordaten 

 

Die Symbolik kann durch den Layer Editor entweder mit einen Doppelklick auf das Thema 

oder einen Rechtsklick Eigenschaften geändert werden. Hier muss man sagen, dass der 

Layer Editor sehr ungewöhnlich ist und hinsichtlich der Benutzerfreundlichkeit einiges zu 

wünschen übrig lässt.  

Es ist nur eine benutzerdefinierte Transparenz für Flächen möglich, die aber nicht über 

einen Schieberegler, sondern in Prozentwerten angegeben wird. 

Darstellungsmöglichkeiten, wie Wertebereich und Einzelwert, die teilweise von allen an-

deren Viewern gegeben sind, fehlen hier gänzlich. 

 

 
                                       Abb. 29: Layer Editor der Symbolik des Map Window 

  

Hinzu kommt, dass für die Farbwahl kein Farbmischer zur Verfügung steht. Entweder 

muss eine Farbe aus der vorgegebenen Farbpalette gewählt, oder sie kann vom Benutzer 

als RGB-Wert numerisch eingegeben werden (siehe Abb. 29:). Das ist sehr umständlich, 

denn so kann die Farbgebung nicht rein optisch erfolgen und setzt das Wissen der RGB-

Werte voraus.  
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Es können Muster für Flächen, unterschiedliche Linienarten als auch verschiedene Punkt-

symbole vergeben werden.  

Benutzerdefinierte Punktsymbole kann man aber nicht importieren. 

Eine Beschriftung der Geometrieelemente ist möglich. 

Die Benutzerfreundlichkeit erhält die Bewertung schlecht. 

 

 

2.6.4 Lesen von georeferenzierten Rasterdaten 

 

Map Window liest GeoTIFF, TIFF mit tfw, JPEG mit jgw, PNG mit pgw. Rasterbilder des 

Format GIF mit gfw sollten vom Programm geöffnet werden, da das Format unterstützt 

wird. Jedoch tritt eine Fehlermeldung auf: 

 

 
Abb. 30: Fehlermeldung beim Import 

 eines georeferenzierten  GIF 

 

Zu erwähnen ist, dass die georeferenzierten Rasterdaten nicht nebeneinander liegen,  

obwohl es benachbarte Kartenblätter sind (siehe Abb. 31:). 

 

 
             Abb. 31: Vier benachbarte Kartenblätter grenzen nicht aneinander an 



 69 

 

Getestet wurden vier Kartenblätter der DTK 25 (Blatt: 7733, 7734, 7833, 7834).  

Diese müssten dicht beieinander liegen. Wie zu erkennen ist, tritt hier ein Fehler auf. 

 

 

2.6.5 grafische Ausprägung der Rasterdaten 

 

Das Menü für Rasterdaten lässt sich analog zu dem der Vektordaten öffnen. 

Die Transparenz kann nicht für das gesamte Bild, sonder nur für einen Farbwert bei 

Palettenbildern numerisch eingestellt werden.  

Farben können genauso wenig verändert werden wie die Helligkeit.  

Die Benutzerfreundlichkeit dieses Menü’s ist genauso schlecht gelöst, wie bei der 

grafischen Ausprägungen von Vektordaten und erhält somit auch eine schlechte 

Bewertung. 

 

 

2.6.6 geografische Abfragen 

 

Die Attributtabelle wird entweder über das Icon in der Menüleiste, oder einen Rechtsklick 

auf das Thema Attributtabelle anzeigen geöffnet. Auch hier gibt es Funktionen, um bei-

spielsweise nur die selektierten Datensätze anzeigen zu lassen.  

Der Query Builder wird über das Icon oberhalb der Tabelle gestartet. Die attributive Ab-

frage erfolgt durch SQL. 

Eine Join-Funktion der Tabellen ist nicht vorhanden. 

Bei den räumlichen Abfragen sind nur die Funktionen Puffer und Merge vorhanden. Die 

Funktion Puffer kann über den Reiter GIS Tools >  Vektor >  Buffer Shapes gestartet 

werden.  

Zusätzlich besteht noch die Möglichkeit, die Funktion Merge durchzuführen. Diese be-

findet sich, wie die Pufferbildung, ebenfalls unter GIS Tools >  Vektor >  Merge Shape-

files.  

Es gibt keine beschreibenden Texte oder Abbildungen zu den Funktionen. 
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2.6.7 Performance 

 

Vektor 

Der Map Window war bei dem ersten Test mit einer Dateigröße von 27 MB sehr über-

zeugend. Bei den nachfolgenden Untersuchungen mit größeren Dateien konnte der 

Viewer nicht mehr so überzeugen. Hauptsächlich die Funktionen, wie Attributtabelle 

öffnen und den attributiven Abfragen, lassen bei der Wartezeit  noch einiges zu wünschen 

übrig. Das Ergebnis des zweiten und dritten Tests ergibt eine mittelmäßige Wertung. 

 

 27 MB 83 MB 144 MB 
Lesen ●● ●● ● 
Zoom ●● ● ● 
Verschieben ●● ● (●) 
Symbolik ändern ●● ● ● 
Tabelle öffnen ● (●) (●) 
attributive Abfrage ●● (●) (●) 
Ergebnis ●● ● ● 
Tabelle 11: Vektorperformance des Map Window 4.7.3 

 

 

Raster 

Das Programm ist bei der Performance der Rasterdaten in allen Tests mittelmäßig. 

 

 85 MB 263 MB 577 MB 
Lesen ● ● ● 
Zoom ● ● ● 

Verschieben ● (●) (●) 
Transparenz ● ● ● 

Ergebnis ● ● ● 
Tabelle 12: Rasterperformance des Map Window 4.7.3 

 

 

2.6.8 Digitalisierung 

 

Es besteht keine Möglichkeit zur Digitalisierung. 

 

 

2.6.9 WMS-/WFS-Dienste 

 

Der Viewer Map Window kann weder WMS-, noch WFS-Dienste nutzen. 
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2.6.10 Druckfunktionalität 

 

Die Einstellungen für den Druck befinden sich unter dem Reiter Datei >  Drucken.  

Es öffnet sich ein Fenster mit einer Vorschau (siehe Abb. 32:).  

 

 
       Abb. 32: Druckmenü mit Vorschaufenster 

 

Hier kann über das Icon Insert Map der Karteninhalt importiert werden. Die Größe kann 

man durch Aufziehen eines Rechteckes bestimmen.  

Auch Textfeld können erstellt werden. Die Eingabe des Textes erfolgt über das 

Menüfenster rechts unten, und ist, wie bei allen Einstellungen, nicht gut gelöst. 

Es können auch eine Legende und eine Maßstabsleiste hinzugefügt werden.  

Jedoch ist die Maßstabsleiste auf dem DIN A4 Ausdruck nicht korrekt. 

Die Kartenkomponenten sind mit der Maus händisch zu platzieren und zu verschieben. 

Die Seitengröße ist unter dem Reiter File > Page Setup einzustellen.  

Der Drucker wird unter File > Choose printer gewählt. Danach kann über das Icon Print 

der Druckauftrag gestartet werden. 

Der Maßstab wird unter dem Reiter Ansicht > Kartenmaßstab wählen bestimmt. Der 

Maßstab ist nur bei dem Druck auf DIN A3 korrekt, aber nicht auf DIN A4. Somit ist ein 

maßstabsorientiertes Drucken nicht möglich.  
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2.6.11 Schreiben von Vektordaten 

 

Vektordaten können als Shape-File geschrieben werden. Dazu ist unter dem Reiter 

PlugIns die Funktion GIS Tools zu aktivieren.  

Über GIS Tools > Vektor >  Export Selected Shapes to New Shapefile können nun 

Shape–Dateien erstellt werden.  

Die zu schreibenden Vektoren sind vorher zu selektieren.  

Vektoren im DXF-, oder GML-Format kann man nicht speichern. 

 

 

2.6.12 Schreiben von Bildern 

 

Bilder können unter dem Reiter Bearbeiten >  Exportieren > Karte als Bild speichern 

geschrieben werden. 

Das Schreiben von Bildern ist laut der Liste des Dateityps in folgenden Formaten 

möglich: Bitmap, GIF, PNG, JPG. 

Was hier auffällt ist, dass die Formate nicht gewählt werden können (siehe Abb. 33:). 

 

 
        Abb. 33: Menü zum Speichern von Bildern 

 

Das Programm schreibt automatisch das Bild im Bitmap-Format. Für GIF oder JPG muss 

die Dateiendung selbstständig hinter den Dateinamen gesetzt werden. 
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Beim Speichern im PNG-Format tritt eine Fehlermeldung auf: 

 

 
             Abb. 34: Fehlermeldung beim Speichern eines Bildes im PNG-Format 

 

Das Schreiben von Bildern im TIFF-Format ist nicht möglich. 

 

 

2.6.13 Schreiben von georeferenzierten Rasterdaten 

 

Das Speichern von georeferenzierten Rasterdaten ist ähnlich dem Schreiben von Bildern. 

Das Menü befindet sich unter dem Reiter: Bearbeiten > Exportieren > Karte als geo-

referenziertes Bild speichern.  

Die zur Verfügung stehenden Formate sind: JPG (jgw), GIF (gfw) und BMP (bpw). Anders 

als im Abschnitt 2.6.12 (Schreiben von Bildern) können hier die Formate aus der Liste 

gewählt werden. Die Dateiendung muss nicht eigens hinter den Dateinamen geschrieben 

werden.  

Das Schreiben als GeoTIFF, TIFF (tfw) und PNG (pgw) ist nicht möglich. 

 

 

2.6.14 Fazit 

 

Der Map Window 4.7.3 liest von den Vektorformaten das Shape-File. Die grafische 

Ausprägung der Geodaten ist eingeschränkt. Bei den Vektordaten fehlen die Darstel-

lungsmöglichkeiten Wertebereich und Einzelwert. Rasterbilder können nicht transparent 

geschalten werden. Für Aufgaben, wie dem räumlichen Abfragen, dem Digitalisieren von 

Vektoren und der Nutzung von Online-Diensten ist dieses Programm nicht geeignet. Das 

Schreiben von Vektordaten und Rasterdaten ist nur teilweise gegeben. Die Performance 

ist mittelmäßig und die Druckfunktionalität zwar gegeben, jedoch nicht maßstabsgetreu. 

Zu erwähnen ist noch die schlechte Menüführung. 

 

Die Software Map Window 4.7.3 erzielte eine Gesamtpunktzahl von 44,1. 
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2.7 Tatuk GIS Viewer 1.13.1.370 

 

2.7.1 Benutzeroberfläche 

 

Die Menüleiste des Tatuk GIS Viewer ist nicht mit Icons überladen. Die Icons sind groß 

genug, lassen sich aber auf den ersten Blick nicht immer gleich den Funktionen zu-

ordnen. Die farbliche Gestaltung in blau ist zu Beginn gewöhnungsbedürftig. Beim Öffnen 

des Programms befindet sich die Themenleiste (im Gegensatz zu den anderen Viewern) 

auf der rechten Seite, doch sie kann vom Benutzer frei bewegt werden. 

 

 
Abb. 35: Benutzeroberfläche von Tatuk GIS Viewer 1.13.1.370 
 

Alles in allem ist die Benutzeroberfläche übersichtlich und in deutscher Sprache. Ähnlich 

dem Viewer uDIG befindet sich die Attributtabelle nach dem Öffnen durch den Button 

Data unterhalb des Anzeigefensters. 

Die Benutzeroberfläche erhält eine mittelmäßige Bewertung. 

 

 

 

 



 75 

2.7.2 Lesen von Vektordaten 

 

Es werden alle drei, in dieser Diplomarbeit untersuchten Vektorformate, Shape, DXF und 

GML in den Versionen 2.x und 3.x, von dem Programm gelesen. 

 

 

2.7.3 grafische Ausprägung der Vektordaten 

 

Das Menü für die Darstellung von Vektordaten kann über einen Doppelklick auf das 

Thema in der Themenleiste, oder über den Reiter Layer > Properties… in der Menüleiste 

aufgerufen werden.  

Der Reiter Area verwaltet die Symbolik. 

Eine Transparenzeinstellung ist nicht vorhanden.  

Es besteht lediglich die Möglichkeit, die Objekte komplett transparent (100 Prozent) zu 

schalten. 

Die Darstellungsmöglichkeit beruht ausschließlich auf dem Einheitssymbol (siehe Abb. 

36). Es gibt keine Möglichkeit der Darstellung eines Wertebereiches oder der Einzelwerte. 

 

 
         Abb. 36: Menü der Symbolik des Tatuk GIS-Viewers 
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Die Farbwahl kann mit Hilfe eines Farbmischers getroffen werden.  

Zusätzlich können Muster für Flächen, unterschiedliche Linienarten und Punktsymbole 

gewählt werden.  

Benutzerdefinierte Punktsymbole können importiert und Geometrieelemente beschriftet 

werden. 

Die Benutzerfreundlichkeit erhält die Bewertung mittelmäßig. 

 

 

2.7.4 Lesen von georeferenzierten Rasterdaten 

 

Es werden die georeferenzierten Rasterbilder folgender Formate gelesen: GeoTIFF, TIFF 

mit tfw, JPG mit jgw, GIF mit gfw.  

Beim Öffnen des PNG mit pgw tritt folgende Fehlermeldung auf: 

 

 
       Abb. 37: Fehlermeldung beim Öffnen eines georeferenzierten PNG’s mit pgw 

 

 

2.7.5 grafische Ausprägung der Rasterdaten 

 

Das Menü der Einstellungen von Rasterdateien kann ähnlich, wie das der Vektordaten, 

geöffnet werden (siehe Abschnitt 2.7.3). 

Die Transparenz wird für das gesamte Bild, zwar nicht über einen Schieberegler, jedoch 

numerisch definiert. 

Eine Transparenz für einzelne Farbwerte, sowie das Ändern einzelner Farbwerte kann 

nicht eingestellt werden. 

Die Beeinflussung der Helligkeit ist nicht gegeben. 

Die Benutzerfreundlichkeit dieses Menüs ist mittelmäßig bewertet. 

 

 

2.7.6 geografische Abfragen 

 

Die Attributtabelle kann über das Icon Data in der Menüleiste aufgerufen werden. Sie 

erscheint unterhalb des Anzeigefensters, was gewöhnungsbedürftig ist.  
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Das Fenster mit der Tabelle kann verschoben und in der Größe verändert werden, was zu 

empfehlen ist. 

Auch attributive Abfragen über den Query Builder (siehe Abb. 38) fallen zu Beginn nicht 

leicht. Um den Query Builder zu aktivieren, muss das kleine schwarze Rechteck oberhalb 

der Spaltenbezeichnungen gedrückt werden. In dem Feld erscheinen nun die vorhande-

nen Werte. Klickt man auf custom… gelangt man zu dem custom query. Nun können die 

Operatoren (like, equals, is less than usw.) gewählt und der Text oder die Zahl für die 

Abfrage eingegeben werden. Mit Ok wird die Abfrage gestartet. 

 

 
     Abb. 38: Query Builder des Tatuk GIS Viewers 

 

Ein Join zweier Tabellen kann nicht durchgeführt werden. 

Auch räumliche Abfragen, wie Puffer-, Dissolve-, Intersect-, Union- oder Merge-

Funktionen stehen nicht zur Verfügung. 

 

 

2.7.7 Performance 

 

Vektor 

Der Tatuk GIS Viewer war in allen drei Untersuchungen wirklich überraschend gut. Einzig 

beim Öffnen der Attributtabelle gab es noch etwas Spielraum nach oben. In der Perfor-

mance steht das Programm dem gvSIG in nichts nach und ist für eine Bearbeitung auch 

mit größeren Dateien zu empfehlen. 

 

 27 MB 83 MB 144 MB 
Lesen ●● ●● ●(●) 
Zoom ●● ●● ● 
Verschieben ●● ● ● 
Symbolik ändern ●● ●● ●(●) 
Tabelle öffnen ●● ●(●) ●(●) 
attributive Abfrage ● ● ● 
Ergebnis ●● ●● ●● 
Tabelle 13: Vektorperformance des Tatuk  GIS Viewers 1.13.1.370 
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Raster 

Die gute Performance der Vektordaten spiegelt sich auch bei den Rasterdaten wieder. 

Das Ergebnis bei allen drei Untersuchungen war gut. 

 

 85 MB 263 MB 577 MB 
Lesen ●● ●● ● 
Zoom ●● ●● ●(●) 
Verschieben ●● ●● ●(●) 
Transparenz ●● ●(●) ●(●) 
Ergebnis ●● ●● ●● 
Tabelle 14: Rasterperformance des Tatuk  GIS Viewers 1.13.1.370 

 

 

2.7.8 Digitalisierung 

 

Es ist keine Funktion für die Digitalisierung vorhanden. 

 

 

2.7.9 WMS-/WFS-Dienste 

 

Der Tatuk GIS Viewer hat die Möglichkeit, über Datei > Open from Server durch die 

Eingabe einer URL auf einen WMS-Dienst zuzugreifen. Es gibt hier jedoch keine 

Metadaten und Einstellungen. Es können weder das Format, noch die Projektion gewählt 

werden. Außerdem gibt es keine Layerdifferenzierung, d.h. alle über die URL verfügbaren 

Rasterbilder erscheinen in der Themenleiste als ein Thema und werden je nach Zoom-

stufe dargestellt. 

Ähnlich, wie beim WMS-Dienst verhält es sich bei dem Import eines WFS-Layers. Über 

Datei > Open from Server kann auch auf einen WFS-Server zugegriffen werden. Auch 

hier erhält man keine Informationen zu den Daten. Sie werden einfach komplett in den 

Viewer geladen. Es ist nur eine Schnittstelle für den WFS-Import von GML in der Version 

2.x vorhanden. 

 

 

2.7.10 Druckfunktionalität 

 

Die Druckvorschau kann entweder über das Icon Druckvorschau… in der Menüleiste oder 

über den Reiter File > Vorschau geöffnet werden (siehe Abb. 39:). 
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           Abb. 39: Druckvorschau 
 

Es können zwar Textelemente und eine Legende erzeugt, doch weder die Größe noch die 

Position variiert werden. 

Eine Maßstabsleiste kann nicht gedruckt werden.  

Zusätzlich fehlt der Inhalt der Legende bei meinen Testdrucken. 

Um in einem festgelegten Maßstab zu drucken, ist vorher unter dem Reiter Karte > Map 

units… die richtige Maßeinheit (Meter) auszuwählen. Danach kann unter dem Anzeige-

fenster in das Feld der gewünschte Maßstab eingetragen werden. Zusätzlich ist in der 

Druckvorschau unter visible extent ein Haken zu setzen und der Button Aktualisieren 

(siehe Abb. 39) zu drücken. Der abgebildete Maßstab ist nicht korrekt. Die Kartengrafik 

ist bei dem DIN A3-Druck größer als auf dem DIN A4 Blatt, obwohl für beide ein Maßstab 

von 1:25.000 festgelegt wurde. Somit ist ein maßstabsorientiertes Drucken nicht gege-

ben.  

Der Druckvorgang dauert hier länger als bei den anderen Viewern. 
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2.7.11 Schreiben von Vektordaten 

 

Das Schreiben von Vektordaten ist mit dem Tatuk GIS Viewer weder als Shape-, DXF- 

oder GML-Datei möglich. 

 

 

2.7.12 Schreiben von Bildern 

 

Bilder können über den Reiter File > Export to Image gespeichert werden. Die hier zur 

Verfügung stehenden Formate sind: TIFF, JPG, PNG und BMP, jedoch kein GIF. 

 

 
    Abb. 40: Einstellungsmöglichkeiten beim Speichern eines Bildes im JPG-Format 

 

Die Abb. 40 zeigt die Parameter, die für das Speichern von Bildern zur Verfügung stehen.  

In diesem Beispiel handelt es sich um das JPG-Format. Beeinflussbar sind Farbtiefe (24 

Bit bei RGB), Kompression, Ausdehnung und Auflösung. 

Ein Hinweis tritt beim Speichern von JPG- und PNG-Dateien auf: 

 

 
                       Abb. 41: Hinweis beim Speichern im JPG und PNG-Format 

 

Dieser Hinweis besagt, dass das Speichern von Bildern über eine Dateigröße von 25 MB 

nicht empfehlenswert ist.  



 81 

Beim Schreiben des Bildes entstehen zusätzlich noch zwei weitere Dateien. Diese dienen 

der Georeferenzierung des Bildes (siehe Abschnitt 2.7.13.). 

 

 

2.7.13 Schreiben von georeferenzierten Rasterdaten 

 

Ähnlich dem Schreiben von Bildern können die Formate TIFF, JPG und PNG gespeichert 

werden. Ein Export als GeoTIFF ist nicht möglich. 

Wie im Abschnitt 2.7.12 (Schreiben von Bildern) schon erwähnt, entstehen zu dem 

Rasterbild zwei weitere Dateien. Die eine ist das World File, welches das Bild räumlich 

definiert. Die andere Datei hat die Endung *.tab (siehe Abb. 42:). Sie kann mit Hilfe des 

Editors betrachtet werden: 

 

 
Abb. 42: *.tab-Datei des geschriebenen Bildes  

 

Auch diese Datei dient der Georeferenzierung. Hier werden drei Ecken des Bildes durch 

ihre Koordinaten definiert. 

 

 

2.7.14 Fazit 

 

Die Aufgaben eines GIS-Viewers erfüllt die Software Tatuk GIS Viewer 1.13.1.370, 

obwohl die Darstellungsmöglichkeiten Wertebereich und Einzelwert nicht vorhanden sind. 

Er liest alle Vektorformate (auch GML 3.x). Weitere Aufgaben, wie räumliche Abfragen, 

Digitalisierung, Import von Online-Diensten und die Druckerstellung können mit diesem 

Programm nicht zufriedenstellend erfüllt werden. Das Schreiben von Vektordaten ist nicht 

gegeben. Positiv muss die Performance erwähnt werden, die in allen Bereichen die beste 

aller Viewer ist.  

 

Der Tatuk GIS Viewer 1.13.1.370 erhält insgesamt 56,7 Punkte. 
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2.8 Global Mapper 11.02 

 

2.8.1 Benutzeroberfläche 

 

Auf den ersten Blick sieht die Benutzeroberfläche des Global Mappers 11.02 ähnlich wie 

bei den anderen GIS-Viewern aus. Dennoch hebt sie sich von den anderen Programmen 

deutlich ab. Das wird zunächst nach dem Importieren von Daten deutlich, weil die 

Themenleiste (bei fast allen anderen Viewern auf der linken Seite) fehlt.  

 

 
Abb. 43: Benutzeroberfläche des Global Mapper 11.02 

 

Die Übersicht der Themen (Layer) und somit auch die Reihenfolge der Darstellung, findet 

man unter dem Button Open Control Center in der Menüleiste (siehe Abb. 44). Die Icons 

sind groß genug und grafisch gut interpretierbar. Unterhalb des Anzeigefensters befinden 

sich Informationen über den angezeigten Maßstab und die Koordinaten. 
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                    Abb. 44: Themenübersicht 
 

Die Benutzeroberfläche ist nicht in deutsch, sondern in englisch und erhält eine 

mittelmäßige Bewertung. 

 

 

2.8.2 Lesen von Vektordaten 

 

Zunächst muss hier erwähnt werden, dass die Software als Freeware in ihren Funktionen 

beschränkt ist. Für eine vollständige Nutzung benötigt man eine Registrierung, die kos-

tenpflichtig ist. Es können in der unregistrierten Version nicht mehr als vier Daten gela-

den werden (vgl. http://www.globalmapper.com/product/download.htm). Ansonsten liest 

das Programm alle in die Untersuchung einbezogenen Vektorformate: Shape, DXF und 

GML in den Versionen 2.x und 3.x. Der Global Mapper ist das einzige Programm, welches 

beim Importieren von Vektordaten streng nach der Projektion fragt (siehe Abb. 45). 
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           Abb. 45: Menü für die Projektion der Vektordaten 

 

 

2.8.3 grafische Ausprägung der Vektordaten 

 

Das Menü für die grafische Ausprägung von Vektordaten kann über das Icon Configu-

ration in der Menüleiste geöffnet werden (siehe Abb. 46). Es gibt für die Geometriearten 

Punkt, Linie und Flächen jeweils einen eigenen Reiter Point Styles, Line Styles und Area 

Styles. Das Programm kommt aus Amerika und hat eine Menge vordefinierter Darstel-

lungsstile (Bsp.: River, Interstate usw.), die dort üblich sind. 

Eine Transparenz kann für flächenhafte Geometrien mit Hilfe eines Schiebereglers einge-

stellt werden. 

Die Farben können über einen Farbmischer im RGB- und HSB-Farbraum definiert werden. 
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               Abb. 46: Menu für die grafische Ausprägung von flächenhaften  
                                                   Vektordaten  

 

Die Funktion Einheitssymbol, bei der allen Objekten eines Themas dieselbe Farbe 

zugewiesen wird, ist vorhanden. Dabei kann entweder einer der schon definierten Stile 

verwendet, oder ein eigener erstellt werden. Dafür muss in der Liste Unknown Type (als 

Beispiel für Flächen: Unknown Area Type) markiert sein. Die Darstellungsmethode Einzel-

wert steht auch zur Verfügung. Sie kann aber nur auf Linien oder Flächen angewendet 

werden. Dafür muss man das Control Center über das Icon in der Menüleiste öffnen. Das 

zu bearbeitende Thema muss markiert sein. Über den Button Options gelangt man zu 

den Vektor Options. Die Einstellungen zu dem Einzelwert kann über den Reiter Area 

Styles oder Line Styles, unter dem Punkt Apply Styling Based on Attribute/Name Values 

erreicht werden (siehe Abb. 47). 
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             Abb. 47: Darstellungsmethode Einzelwert 

 

Zunächst ist das Feld zu definieren, in dem sich die Werte befinden, die farblich darge-

stellt werden sollen. Die in der Tabelle vorhandenen Attributwerte werden jedoch nicht 

aufgelistet. Das ist sehr umständlich, weil man so die Werte vorher aus der Tabelle 

ablesen muss. Die Werte und deren grafische Ausprägung können nun unter dem Button 

New Value definiert werden.  

Eine interessante Visualisierung bietet auch die Funktion Interpolate Colors Between 

Numeric Values. Hier wird für die Werte, die dazwischen liegen, die Farben interpoliert.  

In meinem Beispiel (Einwohnerzahlen) ist dem Wert 1.082.516 die Farbe Gelb und dem 

Wert 1.500.000 die Farbe grün zugewiesen. Für den Wert 1.250.000 wird dann eine 

Farbe aus Gelb und Grün interpoliert. 

Die Möglichkeit, einen Wertebereich zu bestimmen, ist nicht gegeben. 

Muster für Flächen können über Fill Pattern vergeben werden.  

Die Linienart kann man unter Drawing Style ändern.  

Punktsymbole werden über Symbol eingestellt. Bei den Punkten ist auffällig, dass die 

Farben des Symbols nicht benutzerdefiniert erstellt werden können. Es sind nur vordefi-

nierte Farben in der Liste enthalten. 
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Vom Benutzer selbst erstellte Punktsymbole können über den Button Add Symbol… 

importiert werden. 

Eine Beschriftung der Geometrien ist unter dem Menu Configuration für Punkte, Linien 

und Flächen zu erstellen. Dazu muss ein Haken unter Label Display gesetzt werden.  

Der Button Select Font… öffnet das Menü für die Schrift. Hier kann die Formatierung der 

Schrift (Schriftart, Größe usw.) definiert werden. Die Beschriftung wird aber erst 

angezeigt, wenn in den Options über Overlay Control Center die Funktion Use Selected 

Attribute Value for Name aktiviert ist. Es kann nun die Spalte für die Beschriftung 

gewählt werden. 

Die Benutzerfreundlichkeit wurde mittelmäßig bewertet. 

 

 

2.8.4 Lesen von georeferenzierten Rasterdaten 

 

Auch hier ist analog zu Abschnitt 2.8.2 (Lesen von Vektordaten) zu erwähnen, dass nur 

vier Rasterdaten geladen werden können. 

Es werden aber alle Rasterformate gelesen: Geotiff, TIFF (tfw), JPG (jgw), PNG (pgw) 

und GIF (gfw). 

 

 

2.8.5 grafische Ausprägung der Rasterdaten 

 

Um das Menü für die Einstellung der Rasterdaten  zu öffnen, muss zuerst das Overlay 

Control Center (Themenübersicht) über das Icon in der Menüleiste geöffnet werden.  

Die Rasterbilder, für die Einstellungen vorgenommen werden sollen, müssen aktiviert 

sein. Danach gelangt man über den Button Options… zu dem Menü Raster Options (siehe 

Abb. 48). 
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                                     Abb. 48: Menu für die grafische Ausprägung von Rasterdaten 

 

Hier kann nun über einen Schieberegler die Transparenz für das gesamte Bild eingestellt 

werden. Die Prozentwerte beziehen sich auf die Opazität (Dichte). 

Eine Transparenz für einzelne Farbwerte ist über den Button Set Transparent Color… 

auszuwählen. Dabei muss ein Haken bei Transparenz gesetzt sein. 

Es können auch einzelne Farbwerte des Bildes verändert werden. Diese Option findet 

man unter dem Reiter Palette. Der zu verändernde Farbwert muss markiert sein und über 

den Button Edit Selected Color… kann eine andere Farbe zugewiesen werden. 

Die Helligkeitseinstellung (Color Intensity) befindet sich wie die Transparenz unter dem 

Reiter Display.  

Die Benutzerfreundlichkeit erhält die Bewertung gut. 

 

 

2.8.6 geografische Abfragen 

 

Die Attributtabelle kann über den Reiter Search > Search by Attribute, Name, and 

Discription in der Menüleiste geöffnet werden (siehe Abb. 49). 
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Abb. 49: Attributtabelle mit Abfrageoptionen 

 

Zunächst können die Attribute nach dem gewünschten Geometrietyp Punkt, Linie und 

Fläche unter Types of Search gefiltert werden.  

Bei der Abfrage von bestimmten Attributen kann unter Search Criteria… zuerst die ge-

wünschte Spalte, dann der Operator (=, <, > usw.) und der Wert eingestellt werden. Da-

nach muss man eingeben, ob das gesuchte Merkmal aus Zahlen oder Text besteht. Die 

Suche wird über den Button New Search! gestartet.  

Eine sinnvolle Funktion liefert der zusätzliche Button Search in existing Results. Hier kann 

die Suche nochmal durch die Eingabe neuer Parameter eingegrenzt werden. 

Es besteht keine Möglichkeit, einen Tabellen-Join durchzuführen. 

Bei den räumlichen Abfragen können Puffer erstellt werden. Dazu muss zunächst das 

Icon Digitizer Tool aktiviert sein. Durch das Öffnen mit der rechten Maustaste sind 

mehrere Funktionen möglich. Darunter ist auch die Pufferfunktion: Create Range 

Ring(s)…. Hierfür ist der Mittelpunkt festzulegen. In dem folgenden Menü können jetzt 

die Anzahl der Ringe und der Radius definiert werden. 

Zusätzlich ist es möglich, Linien und Flächen mit demselben Attributwert zu kombinieren. 

Dies entspricht der Funktion Dissolve. Hierzu muss zunächst wieder der Button Digitizer 

Tool aktiviert sein. Der Mauscursor ist nun im Editiermodus. Angrenzende Linien oder Flä-

chen können nun markiert werden. Danach kann der Befehl Combine Selected Area/Line 

Feature über die rechte Maustaste ausgeführt werden.   

Weitere Funktionen wie Intersect, Union und Merge sind nicht vorhanden. 

 

 

2.8.7 Performance 

 

Vektor 

Der Global Mapper war in der ersten Untersuchung bei den besten und erhielt ein gutes 

Ergebnis. Doch bei den beiden weiteren Testdurchläufen konnte er das Ergebnis nicht 
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halten. Auch hier war das Öffnen der Attributtabelle und die attributive Abfrage nicht 

schnell genug. Das Ergebnis war mittelmäßig. 

 

 27 MB 83 MB 144 MB 
Lesen ●● ●● ● (●) 
Zoom ●● ●● ● 
Verschieben ●● ● ● 
Symbolik ändern ●● ●● ● (●) 
Tabelle öffnen ● ● ● 
attributive Abfrage ● (●) ● ● 
Ergebnis ●● ● ● 
Tabelle 15: Vektorperformance des Global Mapper 11.02 

 

 

Raster 

Die Performance von Rasterdaten ist im ersten Test mit 85 MB gut ausgefallen. Die 

beiden anderen liefern ein mittelmäßiges Ergebnis. 

 

 85 MB 263 MB 577 MB 
Lesen ●● ● ● 
Zoom ● ● ● 

Verschieben ● ● ● 
Transparenz ●● ●● ●(●) 

Ergebnis ●● ● ● 
Tabelle 16: Rasterperformance des Global Mapper 11.02 

 

 

2.8.8 Digitalisierung 

 

Will man ein neues Thema erstellen, so muss man die Digitalisier-Funktion Digitizer Tool 

aktivieren. Jetzt können die Geometrieobjekte (Punkt, Linie, Fläche) gezeichnet werden.  

Abgeschlossen wird das Zeichnen mit der rechten Maustaste. Danach erscheint ein 

Menüfenster, in dem der Themenname, die Attribute und deren Feldbezeichnungen 

bestimmt werden können (siehe Abb. 50). 
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                   Abb. 50: Erstellen eines neuen Geometrieobjektes 

 

Um die erstellten Objekte bearbeiten zu können, muss die Geometrie markiert sein. Da-

nach können die Vektordaten verschoben, skaliert, gedreht und deren Stützpunkte ver-

ändert werden.   

Die digitalisierten Vektordaten kann man in der kostenlosen Version nicht speichern 

(siehe Abschnitt 2.8.11 Schreiben von Vektordaten). 

 

 

2.8.9 WMS-/WFS-Dienste 

 

Auch das Importieren von WMS- und WFS-Diensten ist in der unregistrierten Version 

nicht freigegeben. 

 

 

2.8.10 Druckfunktionalität 

 

Das Druckmenü (siehe Abb. 51) befindet sich unter dem Icon Setup map layout in der 

Menüleiste. In dem Bereich Text können eine Überschrift oder sonstige Textelemente 

gesetzt werden. Ansonsten kann man eine Maßstabsleiste und eine Legende erstellen. 

Die Maßstabsleiste ist aber nicht korrekt. 
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Die einzelnen Kartenkomponenten können nicht mit der Maus händisch platziert werden. 

Es besteht die Möglichkeit, vertikal oder horizontal vom Rand den Abstand in Prozent 

oder Zoll numerisch einzugeben. 

 

 
          Abb. 51: Menü für das Drucklayout 

 

Es kann in den Formatgrößen DIN A3 und DIN A 4 gedruckt werden. 

Um in einem exakten Maßstab zu drucken, muss unter dem Reiter File > Print der Maß-

stab bei dem Punkt Print to Scale eingestellt werden. Leider ist auch diese Funktion in der 

unregistrierten Version nicht freigegeben (siehe Abb. 52). 

 

 
Abb. 52: Beschränkung des maßstabsorientierten 

 Druckens 
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2.8.11 Schreiben von Vektordaten: 

 

Das Schreiben von Vektordaten ist ohne Registrierung in der kostenlosen Version nicht 

möglich. 

 

 

2.8.12 Schreiben von Bildern: 

 

Das Schreiben von Bildern wird in der kostenlosen Version nicht ermöglicht.  

 

 

2.8.13 Schreiben von georeferenzierten Rasterdaten: 

 

Georeferenzierte Rasterdaten können ohne Registrierung nicht geschrieben werden. 

 

 

2.8.14 Fazit: 

 

Der Global Mapper 11.02 ist in seinen Funktionen bei der kostenfreien Version stark ein-

geschränkt. Dass nur vier Daten importiert werden können, sich das Projekt nicht spei-

chern lässt, oder keine Exportmöglichkeiten vorhanden sind, ist nicht gerade eine Em-

pfehlung. Die Freeware ist nur dafür da, sich mit dem Programm vertraut zu machen. 

Dennoch besitzt das Programm eine Menge an Funktionen, mit denen es aus den ande-

ren Viewern herausragt. Die Software liest alle untersuchten Vektor- und Rasterformate.  

Als kostenpflichtige Version ist der Global Mapper wärmstens zu empfehlen.  

 

Der Global Mapper 11.02 erreicht eine Gesamtpunktzahl von 58,4. 
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2.9 TNT Mips free 2009 

 

Ursprünglich sollte das Programm TNT Mips free 2009 auch in dieser Diplomarbeit unter-

sucht werden. Da diese Software eine unlizensierte kostenlose Version von TNT Mips ist, 

sind hier starke Beschränkungen vorhanden. Die Geometrieelemente der Vektordaten 

sind für jedes Thema auf 500 Polygone, 1.500 Linien, 500 Einzelpunkte usw. beschränkt. 

Ein Rasterbild kann nicht gelesen werden, sobald es mehr als das Produkt aus 640 x 480 

Pixeln aufweist. (vgl. http://www.gisteam.de/technik/tntlite-grenzen.htm) 

Diese Beschränkungen sind so gravierend, dass der GIS-Viewer nicht mit den anderen 

verglichen werden kann. Die Performance kann beispielsweise nicht untersucht werden, 

da meine Testdaten zu viele Geometrieelemente enthalten. 

Ein Arbeiten mit TNT Mips free 2009 ist in diesem Umfang nicht möglich. Diese Version 

ist ausschließlich für Testzwecke geeignet. 

Somit ist für das LVG kein Nutzen dieses Programms vorhanden und wurde von mir nicht 

untersucht und bewertet. 
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3. Auswertung 

 

Die Auswertung ergibt folgende Platzierung: 

 

Platz 1 gvSIG 1.9 Platz 5 Tatuk GIS Viewer 1.13.1.370 

Platz 2 Quantum GIS 1.4.0 Platz 6 uDIG 1.1.1 

Platz 3 Spatial Commander 1.0.7-0 Platz 7 Map Window 4.7.3 

Platz 4 Global Mapper 11.02 Platz 8 Arc Explorer 9.3.1 

 

 

Meine persönliche Erfahrung: 

 

Der gvSIG 1.9 schneidet in fast allen Untersuchungskriterien hervorragend ab und ist der 

klare Testsieger. Er erledigt auch Aufgaben, die weit über einen reinen Viewer hinausge-

hen. Dennoch muss der Benutzer sich in die Software zeitintensiv einarbeiten. Die Fülle 

der Funktionen wirkt anfangs etwas hemmend 

 

Bei dem Quantum GIS 1.4.0 ist die Benutzeroberfläche mit den weiterführenden Menüs 

recht gut gelungen und ein Einstieg nicht schwierig. Auch hier gehen die Funktionen über 

die Anforderungen eines reinen Viewers hinaus. Positiv hervor zu heben ist das Nutzen 

des WFS-Dienstes, da der Q GIS als einziges Programm GML 3.x-Daten verarbeiten kann. 

 

Beim Spatial Commander 1.0.7-0 sind die Benutzeroberfläche und Menüführung  noch 

besser gelungen als beim Quantum GIS. Er ist für Anwender zu empfehlen, die nicht zu 

viele Funktionen benötigt und außer dem Expotieren von Shape-Files keine Daten 

schreiben müssen. Das Programm erklärt sich fast von selbst und ist sehr übersichtlich. 

 

Diese drei Viewer haben mich während meinen Untersuchungen am meisten überzeugt. 

Es muss aber erwähnt werden, dass es schwierig ist, alle Programme zu vergleichen. Die 

Viewer stammen teilweise aus unterschiedlichen Zeiten und verfolgen verschiedene 

Zielsetzungen. 
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4. Schlusswort 

 

Die detaillierte Auswertung der Programme ließ Vor- und Nachteile deutlich erkennen. 

Daraus leitete ich eine Bewertungsreihenfolge ab. Mit ihrer Hilfe können sich Anwender 

informieren, und die, für ihre Zwecke geeignete Software, auswählen. Dass Programme 

Mängel aufweisen und Aufgaben besser, manchmal schlechter erledigen, ist nicht neu.  

Dafür kann die vorliegende Diplomarbeit eine Grundlage sein. 
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